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An Introduction to the Guide

This training guide is structured into chapters describing modeling and best practices when
learning and using Autodesk® Revit® 2018, Advance Steel® 2018, and Navisworks® 2018. It is
an introduction to working with Revit, describing the basic methodology with detailed workflows
for the most commonly used tools.

In addition to the text and step-by-step instructions found here, example data sets with drawings
and training videos are provided to enhance the curriculum. The data sets and drawings
referenced throughout the guide are a simple steel structure model and are meant to be used as
practical exercises for learning more about the tools found in Revit, Advance Steel, and
Navisworks. The videos follow closely with the text and provide visual and detailed overviews of
many common modeling practices.

This training guide is based off the following software build number for Revit 2018:

Build number: 18.0.0.420
20170223 _1515(x64)

Sample Set Drawings:

COVER - COVER SHEET
S1 - FOUNDATION PLAN
S2 — FRAMING PLANS

S3 — ELEVATION GRID 1
S4 — ELEVATION GRID 2
S5 — ELEVATION GRID 3
S6 — ELEVATION GRID 4
S7 — ELEVATION GRID A
S8 — ELEVATION GRID B
S9 - ELEVATION GRID C
S10 - ELEVATION GRID D
S11 - ELEVATION OF STAIRS
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1 Welcome

In this chapter:
Autodesk® Revit®
New in Revit 2018

Note: All software tools described in this guide and all remarks related to the product
pertain to the Revit suite.
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1.1 Autodesk® Revit®

Autodesk® Revit® is a design and documentation platform that supports the design, drawings,
and schedules required for building information modeling (BIM). BIM delivers information about
project design, scope, quantities, and phases when you need it.

In the Revit model, every drawing sheet, 2D and 3D view, and schedule is a presentation of
information from the same virtual building model. As you work on the building model, Revit
collects information about the building project and coordinates this information across all other
representations of the project. The Revit parametric change engine automatically coordinates
changes made anywhere—in model views, drawing sheets, schedules, sections, and plans.
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1.2 New in Revit 2018

Learn about new features and enhancements in the 2018 release of the software.

Subscription Features Now Available to Users of Revit 2018

To read the following topics to learn about 2018 enhancements in different areas of the software
go to http://help.autodesk.com/view/RVT/2018/ENU/?quid=GUID-C81929D7-02CB-4BF7-A637-
9B98EC9EB38B

Topics in this section

1. Architectural Enhancements in Revit 2018
Learn about software improvements for architectural features of the software.

2. Mechanical, Electrical, and Plumbing Engineering Enhancements in Revit 2018
Learn about software improvements for mechanical systems, electrical systems,
plumbing systems, and related analysis.

3. Structural Engineering Enhancements in Revit 2018
Learn about software improvements for structural engineering and analysis.

4. Multi-Disciplinary Enhancements in Revit 2018
These enhancements can benéefit all users of the Revit software, regardless of the
discipline they practice.
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2 Installation

In this chapter:
System Requirements and License

Installation

Page 14
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2.1 System Requirements and License

To successfully install Revit 2018 certain system requirements must be met. For more details,
see https://knowledge.autodesk.com/support/revit-products/learn-
explore/caas/sfdcarticles/sfdcarticles/System-requirements-for-Autodesk-Revit-2018-

products.html
Additionally, a license is required to use the software. The license is activated based on the

serial number and product key provided by the channel partner. This information is used during
the installation process.

Once the license is successfully activated, the software can be used per the license rights
purchased. If a serial number is not immediately available, a 30-day trial version may be
installed.
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2.2 Installation

Requirements for a successful installation:

1. In your Windows session, you must be logged in as administrator or must have
administrator rights. If you are not logged in as administrator or you do not have
administrator rights, an error message appears during the installation.

2. The TCP/IP protocol is usually set up properly by Windows. If problems occur, verify the
connection to the license management software by using the ping command. This
command tests the host name and the IP address. If the IP address is confirmed and not
the host name, there might be a problem with the name server. If this is the case, verify
that the queried host name is in the local HOSTS file or in the DNS database.

Note: More than one Revit version can be installed on a computer at the same time.

Autodesk® Revit® 2018 building design software is specifically built for Building Information
Modeling (BIM), including features for architectural design, MEP and structural engineering, and
construction.

Download Revit and learn more about its features and requirements at
http://www.autodesk.com/products/revit-family/free-trial. Log in with Admin privileges to a
computer and follow the installation instructions.

Optional software to install:

The following are optional tools that can be used in conjunction with Revit. Administrator
privileges are required to fully install these files.

1. Autodesk® Navisworks® Manage 2018 project review software products
enables architecture, engineering, and construction professionals to \
holistically review integrated models and data with stakeholders to gain
better control over project outcomes.

Download Navisworks Manage and learn more about its features and requirements at
http://www.autodesk.com/products/navisworks/free-trial. Log in with Admin privileges to
a computer and follow the installation instructions.

2. Autodesk® Advance Steel® 2018 detailing software is built on the

AutoCAD platform. Intelligent 3D modeling tools help you accelerate
accurate design and detailing. Speed time to fabrication and construction
with tools that automatically generate shop drawings and deliverables. S

Download Advance Steel and learn more about its features and requirements at
https://www.autodesk.com/products/advance-steel/free-trial. Log in with Admin privileges
to a computer and follow the installation instructions.

Page 16



AUTODESK REVIT & NAVISWORKS 2018 TRAINING GUIDE
FOR ADVANCE STEEL USERS

3. Autodesk® Advance Steel® 2018 Extension for Revit 2018 allows Revit users to
quickly connect their models to Advance Steel 2018 using the export, import, and
synchronize functionalities to transfer the model BIM data. The synchronization of BIM
data between applications allows the user to update the modifications without having to
reimport the entire structure. The 2018 version enhances the transfer and
synchronization of connections and settings.

The Revit to Advance Steel extension is useful for transferring BIM model
data from a Revit model to Advance Steel. This can save valuable time for
larger models. E

To install the Revit 2018 extension:

1. Go to the Autodesk® Exchange Apps site at
https://apps.exchange.autodesk.com/en. This can also be found online or by
clicking the exchange app button in Revit or Advance Steel.

» |T;-'pt' a keyword or phrase |gﬂ g Sign In - Igl A - ® M

Autodesk Exchange Apps

Launch the Autodesk Exchange Apps website.

Figure 2-1: Exchange App button

n

Search “Advance Steel” in the Autodesk Exchange App store.

Select the “Advance Steel 2018 Extension” link.

4. Click the button labeled “Free.” Please note that you must have Revit 2018
installed.

The install file will begin to download. Open the file and run the install program.
6. Once the install file has finished, the extension is ready to use.

w

i

Note: The user will need to be logged into their free Autodesk account online to
download the extension.
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3 Starting Modeling in Revit

In this appendix:

Setup and Origin

Levels

Grids

Foundation Slabs

Columns

Beams

Bracing

An Introduction to the GuideConnections

Sheet Setup

Additional Resources:

Datasets:
01_Revit_Grids-Elevations-Concrete
02_Revit_Full-Structure

Videos:
01_Revit Intro to Project Origins, Exposing Project Base Point
02_Revit Starting Grids XXX & YYY from Project Base Point
03_Grid Set Up for Project in Revit for Advance Steel 2018
04_Levels Set Up in Revit to go to Advance Steel 2018
05_Concrete Foundations in Revit for Advance Steel 2018
06_Modeling Columns and Beams in Revit for Advance Steel 2018
07_Modeling Beams in Revit for Advance Steel Pt 1
08 _Modeling Beams in Revit for Advance Steel Pt 2
09_Revit Structural Design Sheet Creation

11_ Advance Steel Import Members from Revit

There are two ways to begin modeling a steel structure. The first method, is to model in
Advance Steel. The other method, described in this chapter, is to model the main members in
an Autodesk® Revit® 2018 project and export these to Autodesk® Advance Steel® 2018.

Importing structural members from Revit into Advance Steel has several advantages. First, if a
Revit model already exists, it may be more efficient to check its accuracy and then export the
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existing members. This allows the detailer to avoid modeling the same structural elements in
multiple software platforms; he/she can simply model one time and then export. Another
advantage is that users who are more familiar with modeling in Revit may find it easier to model
main members in Revit and then export to Advance Steel.

Modeling directly in Advance Steel is useful if the user does not have access to Revit or is more
familiar with modeling and drawing in the Autodesk AutoCAD® platform.

It is recommended that the latest & certified Revit 2018 families are used when inserting steel
columns & steel framing.

The following is the link to a help page which lists the certified families in Revit:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-6244E741-5D14-4DAD-AE25-
5069F71B69F3
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3.1 Setup and Origin

The first step in beginning a model in Autodesk® Revit® 2018 is revealing and marking the
origin. Building a model with a clearly defined origin makes coordination with other trades and
models much simpler later in the construction.

To mark the origin:

1. Begin a new project in a Structural Template in Revit.
2. Go to the Level 1 Structural Plans of the Project Browser.

Project Browser - Projectl x
|_:_|---:r:|: Views [all)
El ----- Structural Plans

Figure 3-1: Open Level 01

3. Reveal hidden elements by clicking the lightbulb icon: @

3 o ,;,| Reveal Hidden Elements i

Figure 3-2: Reveal Hidden Elements tool

4. The Project Base Point, or the Origin, is now exposed. Here the user can create model lines

to mark the origin location in order to show the origin location when hidden elements are not
revealed.

ns | Modify ==

A |\ oy &

Model Model “F\)h.m | (Hidden Category) : Site: Project Base Point
Text Line Group-W  Separator KOO —————pou

Model Room & Area =

Figure 3-3: Draw model lines from the revealed origin

5. Make a 10’ model line in the X-direction and one in the Y-direction from the origin.
6. Make a circle with a 5’ radius from the center of the origin. Draw a line from the X and
circle intersection to the Y and circle intersection.
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Rirvesi ciden Etemants
8
Figure 3-4: Model lines from the origin
Note: The red border around the workspace indicates that Hidden elements are visible.
@
7. Unreveal the hidden elements by clicking on the lightbulb icon . The Origin is now

exposed by the model lines created. The spot coordinates shown in Figure 3-5 mark the
center of the model lines as 0’-0”.

N 10'- 0"
EO -0"

Figure 3-5: Origin exposed by model lines
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3.2 Levels

Use the Level tool to define a vertical height or story within a building. You create a level for
each known story or other needed reference of the building (for example, first floor, top of wall,
or bottom of foundation).

To add levels, you must be in a section or elevation view. When you add levels, you can create
an associated plan view.

. Level 3
- - - - - - - T - —" 200-0°

. Level 2

10'-0"

"\ Level 1
... —_— 0-0
\ g T.0. Fnd. Wall

-1 -0

- T.0. Slab
e &-10'-0'

\
\ O\ -, T.0. Footing
\ \

5 -11'- 0"

\\— G 81;)- E:otiﬂt

Figure 3-6 Elevation or Section View of Levels

Levels are finite horizontal planes that act as a reference for level-hosted elements, such as
roofs, floors, and ceilings. You can resize their extents so that they do not display in certain
views.

You can hide level annotations after you add them.
3.21 Add Levels

In addition to creating a level for each story in a building, you can also create reference levels,
such as sill level.

Open the section or elevation view to add levels to.
On the ribbon, click “# (Level).
Architecture tab » Datum panel > “# (Level)

Structure tab » Datum panel » “# (Level)
Place the cursor in the drawing area and click.
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Note: As you place the cursor to create a level, if the cursor aligns to an existing level line, a
temporary vertical dimension displays between the cursor and that level line.

Draw level lines by moving the cursor horizontally.

On the Options Bar, Make Plan View is selected by default. Thus, each level you create is a
story level and has an associated floor plan view and a reflected ceiling plan view. If you click
Plan View Types on the Options Bar, you can choose to create only the view types that you
specify in the Plan View Types dialog. If you clear Make Plan View, the level is considered to be
a non-story level or a reference level; no associated plan view is created. Walls and other level-
based elements can use reference levels as their top or base constraint.

As you draw level lines, the heads and tails of the lines can align to one another. When you
select a level line that is aligned with others, a lock appears to show the alignment. If you move
the level line horizontally, all aligned level lines move with it.

Click when the level line is the correct length.

You can change the name of the level by clicking the number to select it. You can also change
the height of the level by clicking the dimension.

Revit assigns the label (for example, Level 1) and the level symbol @ to the new level. Use
the Project Browser to rename the level, if desired. If you rename the level, you are asked if you
would like to re-name the associated floor plan and the reflected ceiling plan as well.

3.2.2 Create Sample Levels
The next step is creating levels in the model. Levels are made per the specification drawings. In
Revit, Levels are made in an Elevation view.

To create the sample building levels:

1. Open an elevation view and rename the level at elevation 0’-0” as LO0 BASE.

~ Level:
@I . Oll

Figure 3-7: LOO BASE level

2. Make a new level and name it LO1 Ground. Set the elevation to 100’.
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Level 2

1 GROUND]

100-—0"

Figure 3-8: L0O1 GROUND level

3. Continue creating levels per the specification drawings. See the sheets in the appendix.

LDETDPOFCOL &
J, =g ™
._3.‘_,"

& L04 FIRST DECK
~ 119". 0" -

yr LI

_ N LO3 LANDING 4™

SR T OO
LO2 TOP OF
PEDESTAL )

_z_\‘__/f Tor- &

_=\___L01 GROUND

. 100'-0"

Figure 3-9: Levels per specification drawings

Page 24



AUTODESK REVIT & NAVISWORKS 2018 TRAINING GUIDE
FOR ADVANCE STEEL USERS

3.3 View Templates

A view template is a collection of view properties, such as view scale, discipline, detail level, and
visibility settings.

Use view templates to apply standard settings to views. View templates can help to ensure
adherence to office standards and achieve consistency across construction document sets.

Before creating view templates, first think about how you use views. For each type of view (floor
plan, elevation, section, 3D view, and so on), what styles do you use? For example, an architect
may use many styles of floor plan views, such as power and signal, partition, demolition,
furniture, and enlarged.

You can create a view template for each style to control settings for the visibility/graphics
overrides of categories, view scales, detail levels, graphic display options, and more.

3.3.1 Examples

The following examples show a construction floor plan and a presentation floor plan. You
can create a view template for each style with predefined visibility and graphics settings.

o . | = |=1—|-—+—Ir— ----- —5 F 3
|
U || E— -y L =
st e i
[ madl 1] L < i |
— 1 i L
o _;-M—u ! 1
— = by — - — i
—_ —— ] ———— I —
P
° b
|
Figure 3-10 Construction Floor Plan Figure 3-11 Presentation Floor Plan

You can use view templates to control views in the following ways:

Apply properties from a view template to a view. Later changes to the view template do not
affect the view.

Assign a view template to a view, creating a link between the template and the view. Later
changes to the view template are automatically applied to any linked views.

View templates can be transferred from one project to another.
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3.3.2 Create a View Template

You can create a view template by duplicating an existing view template and making necessary
modifications.

You can also create a view template from a project view or directly from the Graphic Display
Options dialog.

To create a view template based on an existing view template

Click View tab » Graphics panel » View Templates drop-down » Manage View Templates.

In the View Templates dialog, under View Templates, use the Discipline filter and the View type
filter to limit the list of view templates.

Templates for each view type contain different sets of view properties. Select the appropriate
view type for the template you are creating.

In the Names list, select the view template to use as a starting point for the new template.
Click [ (Duplicate).

In the New View Template dialog, enter a name for the template, and click OK.

Modify view template property values as needed.

The Include option allows you to select the properties that will be included in the view template.
Clear the Include option to remove properties from the template. For properties that you do not
include in the view template, you do not need to specify a value. These view properties will not
be overridden when you apply the view template.

Click OK.

To create a view template based on the settings of a project view

In the Project Browser, select the view from which you want to create the view template.

Click View tab » Graphics panel » View Templates drop-down » Create Template from Current
View, or right-click and select Create View Template From View.

In the New View Template dialog, enter a name for the template, and click OK.
The View Templates dialog displays.

Modify view template property values as needed.

The Include option allows you to select the properties that will be included in the view template.
Clear the Include option to remove properties. For properties that you do not include in the view
template, you do not need to specify a value. These view properties will not be overridden when
you apply the view template.

Click OK.

To create a view template from the Graphic Display Options dialog

On the View Control Bar, click Visual Style » Graphic Display Options.
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Note: The new view template will reflect the view type of the current view.

In the Graphic Display Options dialog, define the options as desired.

Click Save as View Template.

In the New View Template dialog, enter a name for the template, and click OK.
The View Templates dialog displays.

Modify view template property values as needed.

The Include option allows you to select the properties that will be included in the view template.
Clear the Include option to remove properties. For properties that you do not include in the view
template, you do not need to specify a value. These view properties will not be overridden when
you apply the view template.

Click OK.
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3.4 Grids

Grids are annotation elements that help organize your design.

3.4.1 Add Grids

On the ribbon, click ot (Grid).

Architecture tab » Datum panel » oH (Grid)

Structure tab » Datum panel » st (Grid)

Click Modify | Place Grid tab » Draw panel and select a sketch option.

Use Af (Pick Lines) to snap the grid to an existing line, such as a wall.
(Optional) Click Modify | Place Grid tab » Draw panel » L (Multi-Segment) to sketch grids
requiring more than one segment.

Note: You cannot use the Copy/Monitor tool to monitor and coordinate changes to multi-
segment grids.

Click when the grid is the correct length.
Revit automatically numbers each grid. To change the grid number, click the number, enter the

new value, and press ENTER. You can use letters for grid line values. If you change the first
grid number to a letter, all subsequent grid lines update appropriately.

As you draw grid lines, the heads and tails of the lines can align to one another. If grid lines are
aligned and you select a line, a lock appears to indicate the alignment. If you move the grid
extents, all aligned grid lines move with it.

3.4.2 Create Sample Grids
The next step in setting up the Revit model is creating building grids.

To create the sample building grids:

1. In the Revit model, create a grid line from the origin in the X-direction. Name the grid line
XXX.
2. Create a grid line from the origin in the Y-direction. Name the grid line YYY.

Figure 3-12: XXX and YYY grid lines
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3. Create a grid line in the X-direction 100’ away from grid line XXX. Name the grid A.
4. Create a grid line in the Y-direction 100’ away from grid line YYY. Name the grid 1.

TN
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Figure 3-13: Grid lines 1 and A
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Figure 3-14: Grid lines per specification drawings

Exercise: In this exercise, use Sections 3.1, 3.2, and 3.3 as references to mark the origin,
create elevations, and create grids in the Revit model. To begin, open a New
Revit project with a Structural template.
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3.5 Foundation Slabs

Use the Structural Foundation: Slab tool to sketch a foundation for a model.

Click Structure tab » Foundation panel » <7 (Slab)

GARAGE LEVEL -

10°-0" %

FOUND}'«TION_‘\'-

0-a

Figure 3-15 Foundation Slab

Foundation slabs may be used to model structural floors on a grade, which do not require
support from other structural elements. Foundation slabs may also be used to model complex
foundation shapes that cannot be created using Isolated or Wall Foundation tools.

3.5.1 Create a Foundation Slab

Create a foundation slab by sketching or selecting the walls of the first level of the model.

Click Structure tab » Foundation panel » <7 (Slab)
Specify a foundation slab type from the Type Selector.

Click Modify | Create Floor Boundary tab » Draw panel » Boundary Line and then click 0y (Pick
Walls) to select the walls in your model. Optionally, you can sketch a foundation slab. Use the
sketch tools on the Modify | Create Floor Boundary tab » Draw panel to form the boundary of
the foundation slab. The sketch must form a closed loop or boundary condition.

On the Options Bar, click Extend into wall if you want the offset to be measured from the wall's
core.

On the Options Bar, specify an offset for slab edges in the Offset text box.
Click Modify | Create Floor Boundary tab » Mode panel » v (Finish).

Note: Foundation slabs are added below the level in | |
which they are drawn. Therefore, if you add a \ ,7,7,@3@1&&—14;
foundation slab in Level 1, it is added below Level 1 ‘ |
and will not be visible in the Level 1 plan view. To see ! !
the foundation slab in a plan view, create a new level ‘ ‘
below Level 1, for example, Foundation Level. When ‘ ‘
you create a new level below Level 1, you will also be s R FOLNDATION 4y

able to see the foundation slab as an underlay

(displayed in halftone) in Level 1. Figure 3-16 Foundation Slab below
Foundation Level
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3.5.2 Create a Structural Floor

Create a structural floor by selecting support framing, walls, or by sketching the extent of the
floor.

1. On the ribbon, click & (Structural Floor).
Where is it?

- Architecture tab » Build panel > Floor drop-down » & (Floor: Structural)

Structure tab » Structure panel » Floor drop-down » Con (Floor: Structural)
From the Type Selector, specify a structural floor type.

On the ribbon, click I\ (Boundary Line).
Click I (Pick Walls) and select the bounding walls.

oD

Note: Instead of picking walls you can sketch a structural floor. On the Draw panel of the ribbon,
use the sketch tools to form the boundary of the structural floor. The sketch must form a closed
loop or boundary condition.

5. To change the span direction, click Ml Span Direction, and click the desired edge or line.
6. (Optional) On the Options Bar:

« specify an offset for slab edges.

- select Extend into wall (to core).

P

Figure 3-17 Floor in Sketch Mode

7. On the ribbon, click ¢ (Finish Edit Mode).
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3.6 Columns

Note: It is recommended that the latest & certified Revit 2018 families are used when inserting
steel columns.

The following is the link to a help page which lists the certified families in Revit:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-6244E741-5D 14-4DAD-AE25-5069F71B69F 3

The column tool can be found in the Structure tab in the Structure panel.

| Structure

Beam Wall JColumn | Floor Truss Brace Beam
T T System

Structure u

Figure 3-18: Column tool location

3.6.1 Add Columns

You can add columns in plan views and 3D views. The height of the column is defined by
the Base Level and Top Level properties, as well as offsets.

. Click Architecture tab » Build panel » Column drop-down » i (Column: Architectural).
. On the Options Bar, specify the following:
Rotate after placement. Select this option to rotate the column immediately after placing it.

Level. (3D views only) Select a level for the column's base. For plan views, the view's level
is the base level for the column.

Height. This setting draws the column upward from its base. To draw the column downward
from its base, select Depth.

Level/Unconnected. Select a level for the top of the column, or select Unconnected and
specify the column height.

Room Bounding. Select this option to designate the column as room-bounding before you
place it.

. Click in the drawing area to place the column.

If you need to move the column, select it and drag it to a new position.

Tip: Typically, you align columns when placing them by selecting a grid line or wall. If you
randomly placed them and you want to align them, click Modify tab » Modify panel »

= Align, and select the columns to align. In the middle of the columns are 2 perpendicular
reference planes that you can select for alignment.
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3.6.2 Create Sample Columns
To create sample building columns:

1. Click on the Column tool in the toolbar.

Structure  Systems  Insert  Annotate  Analyze  Massing & Site

IHi|l&-mBM & £ < (3

| (Column| Floor Truss Brace Beam | lsolated Wall Slab | Rebar
M System T
Structure 5 Foundation
b Structural Column (CL)

Adds a vertical load-bearing element to the building model.
Open a plan view or a 3D view to add structural celumns, You can
-Column | place each column manually, or use the At Grids tool to add
columns to selected grid intersections.

= Structural columns can join to structural elements, such as
| Edil beams, braces, and isolated foundations,

0 O
el ASTM | T
ne - _ 4@ ‘
::: I |
| Log

| Press F1 for more help

Figure 3-19: Column tool in the Structure tab

2. Select the column type in the Properties palette by clicking the dropdown list.

Note: If necessary, load additional columns into the project from the Structural Columns
folder under the Libraries folder of the Revit program files. It is recommended to
use the latest AISC steel sections families (AISC 14.1 for US Imperial) because
this provides a smoother workflow between Revit and Advance.
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Properties x

W Shapes-Column
W10x33

Search =
I Concrete-Rectangular-Column

12x18
18x24
24 x 30

1 W Shapes-Column

WEX10
| wioxz3
W10X4g
W12

W14K4: wil
Maost Re
W Shapes-Col

W Shapes-Column

W Shapes-Col

Figure 3-20: Choose the beam type

3. ldentify the column height or depth in the drop downs found directly above the properties
palette. Following the example set, select the height of the top of column to a level.

| Height v 105TOj¥] 9" 0"

LOO BASE
LO1 GROUND
LO2 TOP OF PEDESTAL
LO3 LAMNDING
LO4 FIRST DECK
LOS TOP OF COL

Figure 3-21: Column height selection
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4. Click to place the columns at designated locations.

Figure 3-22: Place columns

5. Continue placing columns per the specification drawings.

&) (@) ) (a)
| | | |
| | | |
_ | | | |
e R e b
| | | |
| | | |
) ! i ! A
| | | |
| | | |
(8) i | . i,
| | | |
| | | |
S L o |
WD f T 1 T
| | | |
A 1 1. L
‘\1 ) (_3/3‘ f\i) ( i )

Figure 3-23: Columns in plan and 3D views
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3.7 Beams

Note: It is recommended that the latest & certified Revit 2018 families are used when inserting
steel framing.

The following is the link to a help page which lists the certified families in Revit:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-6244E741-5D 14-4DAD-AE25-5069F71B69F 3

The beam tool can be found in the Structure tab in the Structure panel.

Architecture  Structure | Systems  Insert  Annotat

#|Q I & W

Bearmn §| Wall Column Floor Truss Brace Beam
M T System

Structure u
Figure 3-24: Beam tool location
To create beams in Revit:

1. Click on the Beam tool in the Structure tab in the toolbar.
Architecture  Structure  Systems  Insert  Annotate  Analy

QO 0 &WEM &

Beam| Wall Column Floor Truss Brace Beam | Isolated
T T System

Structural Framing: Beam (EM)

Adds individual beams, a chain of beams, or beams aleng grid
ywg lines,

Add grids and columns before adding bearns.
I

D |

Figure 3-25: Select beam tool
2. Select the beam type in the Properties palette by clicking the dropdown list.

Note: If necessary, load additional beams into the project from the Structural Framing
folder under the Libraries folder of the Revit program files. It is recommended to
use the latest AISC steel sections families (AISC 14.1 for US Imperial) because
this provides a smoother workflow between Revit and Advance.
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Properties X

\ W Shapes |
WaxX10

Kearch P
)

~l Concrete-Rectangular Beam

12x 24
16x32

5 H55 Square

H356X6X1/2
HS58X8X3/8

::\?::, W Shapes

| waxio

W12X26

W Shapes
W14X30

W16X26
Most Re
W Shapes : W8

Camber Size

Mumber of stu
Enable Analyti

Figure 3-26: Choose the beam type

3. Identify the beam placement plane in the drop down found directly above the properties
palette. Following the example set, select the height location of the beam to a level.

Placement Plane:

: LOO BASE

: LO1 GROUND

: LO2 TOP OF PEDESTAL

: LO3 LANDING
Level : LO4 FIRST DECK

Level : LO5 TOP OF COL

Figure 3-27: Place the beam in a plane

4. In the model, click the point where the beam begins and then click the point where the
beam ends.
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Figure 3-28: Beam placement

5. Continue placing beams per the specification drawings.

WaxI0
WEXID
WeK10
12

WEXID

WEXID

Weko
2

Figure 3-29: Beams in plan and 3D views
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3.8 Bracing

Note: It is recommended that the latest & certified Revit 2018 families are used when inserting
steel framing.

The following is the link to a help page which lists the certified families in Revit:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-6244E741-5D14-4DAD-AE25-5069F71B69F3

The bracing tool can be found in the Structure tab in the Structure panel.

Floor

-

Beam Wall Column

Structure u
Figure 3-30: Bracing tool location

To create bracing in Revit:

1. In the model, go to a plan view. Create a framing elevation view by selecting :

(Framing elevation) in the Create panel of the View tab. Go to the created framing
elevation view.

I View
r— l::l
P 2 B
QB o % B B
Section Calln:nut Plan _| Elevation | Draftigg Duplicate  Legends  Schedules Scope
‘u“na.n.r T Views M View View T T Box
Create

ﬁ Elevation
O_ . .
O Frarning Elevation

Figure 3-31: Framing elevation tool

2. Select the brace tool in the Structure tab in the Structure panel.
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Architecture™ Structure

% O

Bearm Wall Column Floor  Truss

owser - Image-Model.rvt

Systems Insert  Annotate  Analyze Massing &Site  Collaborate

AW

P < [J# 3

Brace| Beam Wall  Slab Rebar Area Path Fz
T Systemn ¥ A
Structure 5 Enundation Beinforcerr

ews [all)

x’i

Structural Framing: Brace (ER)

Adds diagonal structural members connected to beams and
columns.

Figure 3-32: Select brace tool

3. Select the brace type in the Properties palette by clicking the dropdown list.

Note: If necessary, load additional beams into the project from the Structural Framing
folder under the Libraries folder of the Revit program files. It is recommended to
use the latest AISC steel sections families (AISC 14.1 for US Imperial) because
this provides a smoother workflow in Revit.

Properties

b
i

g,

H“‘m L3X3%1/4

L-Angle

|55 arch

e

B
' “‘x.[C—ChanneI

Cax11.s
' lConcrete—RectanguIar Beam

12x 24
16x 32

, H55 Square

HS56X6X1/2
HS58X8K3/8

. L-Angle

L3-1/2¥3-1/245186

L3¥3X1/4

"S5 W Shapes

WEX10

Figure 3-33: Choose the brace type

4. In the model, click the point where the bracing begins and then click the point where the

bracing ends.
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| - +
Figure 3-34: Place the bracing

5. Continue modeling bracing per the specification drawings.

Figure 3-35: Bracing in 3D view

Exercise: In this exercise, use Sections 3.5, 0, and 3.8 as references to create the
columns, beams, and bracing in the model. To begin, open the practice model
01_Revit_Grids-Elevations-Concrete.
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3.9 Connections

Note: It is recommended that the latest & certified Revit 2018 families are used when inserting

steel columns.

The following is the link to a help page which lists the certified families in Revit:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-6244E741-5D 14-4DAD-AE25-5069F71B69F 3

The connection tool can be found in the Structure tab in the Structure panel.

Architecture  Structure = Systems

-

Structure

Insert

% O I & W

Beam Wall Column Floor Truss Brace Beam

Annotate

Analyze

Massing & S

System

o3

Connection

Connection ¥ u

5

Isolated

Fou

Figure 3-36: Connection Tool Location

To create a connection in Revit:

1. Make sure that the Autodesk Steel Connections for Revit Add-On has been installed. If it
has not been installed, only a generic connection will be available in Revit.

2. In Revit, go to the Structure Tab. Select the arrow dropdown under the Connection
Tool in the Connection Panel to load in connections. The Structural Connection
Settings window will open. Under the Connections Tab, Add the desired connections

and click okay.

Structural Connection Settings

Connec tions |Parameters

Connection Group:

All Connections

Available Connections:

e e

Tube base plate
Corner base plate
M Base plate cut

E Base plate with traverse, bolted

E Base plate with traverse, welded

[[: End plate

E755 Binding plates

[ e of rame botte, it haunch

Al None

Loaded Connections:

E: Seated beam connec

tion

Cancel

Help

Figure 3-37: Structural Connection Settings Window

3. Select the connection type in the Properties palette by clicking the dropdown list.
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Properties X
o— Generic Connection Y

Structural
Approval Status

Input Elements

New Structural Connections

v | P93 Edit Type

A

Edit...

» :

Structural Analysis

Code Checking Status Not Calculated

Identity Data

Properties help

Figure 3-38:Connection Type Properties Palette

4. Select the elements to be connected and press enter. The connection will appear.

Figure 3-39: Structural Connection

5. Continue modeling connections per the specification drawings.

Apply

gy B
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3.10 Sheet Setup

After a model is created in Revit, new sheets can be made with information taken from the

model.

To create sheets in Revit:

1. In the Project Browser, right click Sheets and select new sheet.
2. Select a titleblock template for the new sheet.

L01 GROUND
L02 TOP OF PEDESTAL
LO3 LANDING
L04 FIRST DECK
L0 TOP OF COL
Level T - Analytical
Level 2 - Analytical
Site
- Floor Plans.
(i} Ceiling Plans
& 3D Views
Analytical Model
{30}
& Elevations (Building Elevation)
South
West
Legends
[ Schedules/Quantities
Sheets fall)
-2 Familie]
=-[@] Groups
e Revit Links

i | New Sheet

Select titleblocks:

B 11 x 17 Horizontal

130 x 42 Horizontal : E1 30x42 Horizontal
Nore

Select placeholder sheets:

e ]

Canicel

Figure 3-40: New sheet title block template

L05 TOP OF Ol

s a

‘;”7’7'7’53'1?&

3. Click and drag the level from the Project Browser to the open sheet view in the window.
4. Adjust the scale if needed. Adjust the position of the view on the sheet to fit correctly.

Q.99 © o 9w
i i i i i | | |
SO IR SO R B R e MU B Yy
| | | | | | | |
\ \ \ | = \ | | |
\ \ \ \ \ | | |
I A e R R O
| | | | | | | |
S SR ISR U W USRI, IS WU W
| | | | oo | | | i
| | | [ | | | |
i | | | B i i I i
Dﬁ# ****** e jm—m ——! Dﬁ# ******* oo — ——-(®)
LTI @ummome
{\ AUTODESK_ || Ouner .
AR Project Name T —

TA32015 3062541

Figure 3-41: Sheet view of LO1 and L02
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5. Click and drag an elevation view to a new sheet to create elevation sheets.

© o o o

{\ AUTODESK. ||Owner

T——— Project Name e

Figure 3-42: Elevation view of sheet

Exercise: In this exercise, use Section 3.9 as a reference to create the sheets for the
model. To begin, open the practice model 02_Revit_Full-Structure.
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In this chapter:

Exporting from Revit to Advance Steel
Exporting to Navisworks

Exporting CAD Formats

Exporting IFC Files

Additional Resources:
Datasets:

02_Revit_Full-Structure

Videos:

25 Synchronization between Advance Steel and Revit 2018
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This chapter will address how to export the Revit model to various other platforms and file

formats. It will include steps demonstrating how to export the model to other Autodesk®

software as well as exporting Advance Steel model information to work with other systems and
file formats. Many of the tools for exporting are found in the Export tab in the Revit panel.

ReEHG-GR-2- 8 2-FA0A G- 5

Architecture

Structure

Systerns  Insert

Annctate  Analy:

= over
E Save
E’ Save As

ol =

Eﬁ; Export

Suite

Eﬁ Warkflow
5

ﬁé‘; Publish
@ Print

Close
g

Creates exchange files and sets options.

CAD

I E B e

1N

XL

®
=)

CAD Formats
Creates WG, DXF, DGHM, or SAT files, '
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Figure 4-1: Exporting tools location
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4.1 Exporting from Revit to Advance Steel

Once the main members have been modeled in Revit, and best practices for showing the origin
and setting up a project with levels and gridlines have been followed, the model can be exported
to Advance Steel to finish the detailing.

Starting a project in Revit and exporting members from it requires installation of the extension
for Advance Steel installed in Revit. Please see Chapter 2 for step-by-step details of how to
install the extension from the Autodesk® Exchange Apps site.

Notes: Always check dimensional accuracy in your Revit Model before you import into
Advance Steel. Dimensions may not always be correct according to the
construction documents, and any errors in dimensional control will also be
transferred into Advance Steel when exporting members out of Revit.

Please have the latest family downloaded for AISC structural members in Revit
Structures. Information embedded in these members will transfer into Advance
Steel for labeling information.

To export the Revit model into Advance Steel:
1. Select the Add-Ins tab in the Revit tool bar.

-4 E‘EI d -~ "SELSOA 89 |.=_:_| 8- = Autodesk Revit 2018 - Steel Revit modelavi - 30 View: (3D)
m Architecture  Structure  Systems  Insemt  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Maodify ==

D £ S @ ~dBw~ B | A ;
Modify

External _ Batch Print  Transmita model About Check Manage About Launch WSM Advance Steel Convert RFA  About Formlt
Tools Extension to Formit >

Select = External Batch Print eTransmit Model Review WoarksharningMonitor - Advance Steel Extension Formit Converter

Figure 4-2: Location for Advance Steel Extension in Revit tool bar

N

Select the Advance Steel Extension drop down arrow and choose Export.
3. The Export utilities window will appear. This example only shows the default options for
exporting into Advance Steel.

.3 Export utilities

ADVANCE STEEL

Detailing and Fabrication

/\ AUTODESK.

BExpaort to file format

(®) Advance export

() Other formats SDNF - Version 3.0
Country Library us Y]
O —
/\ AUTODESK Cancel
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Figure 4-3: Export window from Revit

4. Save the Revit export file in the desired file location.
5. Open Advance Steel and select the Export & Import tab.
6. Select Import Revit icon.

B T

Home  Objects  Extended Modeling  Output  View  Labels & Dimensions | Export & Import

Import Export Synchronize Exportto Mavisworks Export [FC Export CIS/2  Export SDNF Advance export
P P i P F F F

-

Rewit Mavisworks Exchange formats =

Figure 4-4: Location of import icon in Advance Steel tool bar

7. Navigate to the file location where the Revit export file was saved and open the file.
8. All main structural members will load into Advance and are ready to be used in the
model.

Note: Some objects from Revit may not be automatically recognized by Advance Steel
and may need to be manually mapped.

Exercise: In this exercise, use Section 3 as a reference to export the Revit model to
Advance Steel. To begin, open the practice model 02_Revit_Full-Structure and
import the model into a new Advance Steel drawing.
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4.1.1 Synchronization (Revit & Advance)
Synchronization is a process that allows you to update your modifications between Revit and
Advance Steel using the .smlx file format, without having to re-import the entire structure.

Use the synchronization process to update the Advance model with changes made in Revit (and
vice versa). The Synchronize tool is found in the Export & Import tab in the Revit panel.

SRR

Home  Objects  Extended Modeling  Output  View  Labels & Dimensions | Export & Import

Import Export Synchronize Export to Mavisworks  Export [FC Export CIS/2  Export SDNF Advance export

-

Rewit Mavisworks Exchange formats =

Figure 4-5: Synchronize tool location
Synchronization workflow:

1. Export your model with structural elements from Revit to Advance Steel through the
extension, using the .smlix format. (See Section 1 for steps to export to Advance).
2. If you make modifications to the Revit model, re-export the modified model from Revit

using the extension and replace the .smix file with the new export.
3. Go back to Advance Steel and open the Synchronization dialog box by clicking .
@@ Refresh
4. Click Refresh in the dialog box to update the .smix file. You can also use
the Load button to reload the .smix file for synchronization.

Y Synchronisation - Image-Model.smix = (=l
E@ Refresh | Report... =;l Apply All Actions
[}Modiﬁed 7/23/2015 Loaded 7/23/2015
Element type Model object Change [ status

Bl Appended I Modified Bl Deleted

() Filter

Figure 4-6: Synchronization dialog box
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5. The modified .smix file is compared to the already loaded model. All modifications found
between the two versions of the model will be displayed. The modifications for each
object will appear in a filterable list.

6. The synchronization marks all the new objects or the existing ones with geometrical
changes (section size, positioning, rotation etc.) as Modified. New objects are marked as
Appended, and objects that were removed are marked as Deleted.

7. You can apply the modifications partially or totally through a series of options.

Y Synchronisation - Image-Model.smix = =

y Y =
'EEJ Refresh D Report... E:j, Apply All Actions

E}Modiﬂed 7/23/2015 I3 Loaded 7/23/2015

Element type Medel object Change [] status
t/ Beam Section |
b 4 Beam Section |
ﬁ Beam Section D
]’/’ Beam Section |
]’// Beam Section A
1"/’ Beam Section |
1“/’ Beam Section D
If Beam Section |
1’/’ Beam Section |
ﬁ Beam Section O
1’/’ Beam Section |

[ Column CutBackStart

Bl Appended I M odified Bl Deleted

() Filter

Figure 4-7: Apply changes to the model
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4.2 Exporting to Navisworks

You can export 3D models as NWC files to open in Autodesk® Navisworks® 2018. Note that
any elements you do not wish to export to Navisworks must be hidden in Revit prior to

exporting. For example, if the scope box is visible in Revit, the box will export to Navisworks;
however, they can also be hidden in Navisworks if desired.

ReHG-%

(|| =)

ﬁ Save As 3

A= =T Ol W * e =

Architecture  Structure  Systems  Insert  Annotate  Analyz

Ep Export 3

Creates exchange files and sets options.

CAD Formats \
CAD| Creates DWG, DXF, DGN, or SAT files.

DWF/DWFx
Creates DWF or DWFx files,

P
3 Building Site
Exports an ADSK exchange file,

FBX
Saves a 3D view as an FBX file.

Suite

b3 s b
?é Publish 3
@ Print I
Ija Close

Bﬂ Family Types
Exports family types from the current
family to a text (bd) file.

m NWC
Saves the scene as a Navisworks NWC
= ile.

ML

Saves tR gdel as a gbXML file,

IFC
Saves an IFC file,

— ODBC Database
E. J Saves model data to an ODBC

Figure 4-8 Export NWC file location

To export a Revit model to Navisworks:

_

NWC

Saves the scene as a Mavisworks NWC

=¥ file,

1. Open the view that will be exported to Navisworks.

R &

File

2. Select the File ———= tab in the Revit tool bar.

3. Select Export

|—_‘§§» Export

4

then

W,

NWC
Saves the scene as a Mavisworks NWC
file,

export to Navisworks .nwc file format.

in order to

4. In Navisworks, open the model in Navisworks by appending the .nwc file.

NOTE: A .dwg file format will also open in Navisworks Manage, therefore can be exported from
Revit to be opened in Navisworks.
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4.3 Exporting CAD Formats

You can export 3D models as CAD format files to open in other platforms such as Autodesk®
Navisworks® 2018. Note that any elements you do not wish to export to Navisworks must be
hidden in Revit prior to exporting. For example, if the scope box is visible in Revit, the box will
export to Navisworks; however, they can also be hidden in Navisworks if desired.

ReHG -&-

[3[=]

D New
E Open
E Save
g Save As

L3

L3

B e LFON G-OE

Architecture  Structure  Systerns  Insert  Annotate  Ana

Creates exchange files and sets options.

CAD Formats 5
cap| Creates DWG, DXF, DGM, or SAT files,

Eﬁs Export

Suite

20 Workflow
s

=%

@ Publish

@ Print
Close

L g

L3

L3

& DWF/DWFx
9 Creates DWF or DWFx files,

Building Sit: L"
e [ 13, CAD Formats X X DWG
FEX | can| Creates DWG, DXF, DGM, or SAT files,
“F aves a 30 vi
= DXF
Falpily Type:
ExpYrts fami
famil to a tq 4
. a DGM
Eﬁ fSiT:.Esm sC -
- ACIS (SAT)
L gbXML
Saves the me

IFC
Saves an IFC file.

— 0DBC Database
E. J Saves model data to an ODBC

Figure 4-9 Export CAD file location

To export a Revit model to Navisworks:

1. Open the view that will be exported to Navisworks.

R &

File

2. Select the File ——— tab in the Revit tool bar.

3. Select Export
export to a CAD Format file format.

|—_‘§§» Export

4

then

CAD

CAD Formats "
Creates DWG, DEF, DGHN, or SAT files,
in order to

4. Settings can be adjusted in the dialog box to user preferences. Select Next to save the

file.
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4.4 Exporting IFC Files

The Industry Foundation Classes (IFC) data type is a platform neutral, open file format
specification. IFC files (extension .ifc) are object-based file formats containing model data which
are designed to facilitate interoperability between software platforms. IFC files allow the transfer

of intelligent construction elements and building data together with their parameters.

ReHG-G-

S 2SO A -0k

Architecture  Structure  Systems  Insert  Annotate  Ana

Creates exchange files and sets options.

CAD Formats D
lcap| Creates DWG, DXF, DGH, or SAT files.

&
[Yoew o
= open
| -

ﬁ Save As 3
=p Export 3

Suite

DWF/DWFx
Creates DWF or DWFy files.

P
i- i Building Site
Exports an ADSK exchange file,

FBEX
= Saves a 3D view as an FBX filg

Family Types
Exports family typgxfrom the current
family to a text i) file.

®

IFC
Sawves an IFC file,

NWC
E» Savewthe scene as a Mavisworks NWC
fiJel

gbXML

riL
Saves the model as a gbXML file,

IFC
Saves an IFC file.

o ‘;Norkﬂow ]
?é Publish 3
@ Print 3
Ea Close

— 0DBC Database
E. J Saves model data to an ODBC

Figure 4-10: Export IFC tool location

To export a Revit model to an IFC file:

1. Make sure the IFC App is installed and open the view of the model that will be exported.

R &

File

2. Select the File ——— tab in the Revit tool bar.

3. Select Export

|—_‘§§» Export

4

then

IFC
Saves an IFC file,

export to a IFC file format.

in order to
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4. Inthe Export IFC dialog box, setup can be adjusted to user preferences by clicking on
Modify Setup and the save location can be updated.

File name: P:\2016\2016-120_Autodesk_Advance-Revit-Navis-Curriculum\d

Current selected setup: <In-Session Setup> v Modify setup ... ‘

| IFC Version: IFC 2x3 Coordination View 2.0

Projects to export:

¢ | /! O2Revit_Full-Structure.0001

How do | specify an export setup? ’ Export l l Cancel ‘

Figure 4-11: Export IFC Dialog Box

5. Select Export to save the file. The model can now be opened in any 3D modeling
platform.

6. If desired, download the IFC viewer from http://www.ifcbrowser.com/.
7. Select in the Exchange formats panel.
8. To view the IFC model open the IFC viewer from the desktop main menu,

select File, Open and select the .ifc file.
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5 Navisworks Mahage File System

In this chapter:

Navisworks file types

Opening files directly

Exporting from Revit to Navisworks
Exporting from Advance Steel to Navisworks
Appending and merging models

Error! Reference source not found.

Combining Files in Navisworks Example
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5.1 Navisworks file types
Autodesk Navisworks has three native file formats: NWD, NWF, and NWC.

5.1.1 NWD File Format

An NWD file contains all model geometry together with Autodesk Navisworks-specific data,
such as review markups. You can think of an NWD file as a snapshot of the current state of the
model.

NWOD files are very small, as they compress the CAD data by up to 80% of the original size.

5.1.2 NWF File Format

An NWF file contains links to the original native files (as listed on the Selection Tree) together
with Autodesk Navisworks-specific data, such as review markups. No model geometry is saved
with this file format; this makes an NWF considerably smaller in size than an NWD.

5.1.3 NWOC File Format (Cache Files)

By default, when you open or append any native CAD or laser scan files in Autodesk
Navisworks, a cache file is created in the same directory and with the same name as the
original file, but with an .nwc file extension.

NWC files are smaller than the original files, and speed up your access to commonly used files.
When you next open file or append file in Autodesk Navisworks, the data is read from the
corresponding cache file if it is newer than the original file. If the cache file is older, which means
the original file has changed, Autodesk Navisworks converts the updated file, and creates a new
cache file for it.

5.2 Opening files directly

In Autodesk Navisworks you can open files originated from a variety of CAD applications.

You can combine these files together, and create a single Autodesk Navisworks file with a
whole-project view of your model. This file brings together geometry and data created by multi-
disciplinary teams, and enables you to explore and review complex models in real-time.

5.3 Exporting from Revit to Navisworks

Autodesk Navisworks can read native Revit (RVT) files directly. Alternatively, you can use the
file exporter to save your files in NWC format.

The file exporter is available for Revit 2018.

5.3.1 To export NWC files from Revit
1. In Reuvit, click Add-Ins External Tools Autodesk Navisworks.

Note: This option is not available in Demo/Viewer mode. If you are not in demo mode, but do
not have access to the Autodesk Navisworks menu, check if editing view is set to normal, and
the modify tool is selected ( Modify).

2. In the Export Scene As dialog box, enter the name for the Autodesk Navisworks file, and
browse to the desired storage location.
3. Click Save to export the file, or Cancel to return to the application without exporting it.
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5.3.2 To adjust the options for the Revit file exporter
1. In Reuvit, click Add-Ins » External Tools » Autodesk Navisworks.
2. Inthe Export Scene As dialog box, click the Autodesk Navisworks Settings button.
3. Expand the File Exporters node in the Options Editor, and click the Revit page. Use the
options on this page to adjust the settings for future exports of NWC files from Revit.
4. Click OK to save the changes and return to the Export Scene As dialog box.
5. Click Cancel to close the dialog box.

5.4 Exporting from Advance Steel to Navisworks

Autodesk Navisworks can read native Advance Steel (DWG) files through an exported file.

5.4.1 To export DWG files from Advance Steel

1. In Advance Steel, go to the Export & Import Tab and select the Export to Navisworks
option in the Navisworks panel. This will automatically open the model in Navisworks as
a DWEF file. Saving the file will convert it to an NWF.

2. All objects that are visible in Advance Steel during an export will be visible in the
Navisworks model. If certain elements (cameras, lines, etc.) are not desired in the
Navisworks model, they can simply be hidden using before export from Advance Steel.
(To hide model elements in Advance Steel, select them and type "Hideobjects” into the
command bar.) Additionally, the properties associated with elements in Advance Steel
will transfer to the Navisworks model.

3. To change the file type from NWF to NWD, simply save the model as a NWD.

5.5 Appending and merging models

5.5.1 To append 3D models in a multi-sheet file

1. Open a multi-sheet file.

2. If the Sheet Browser window is not displayed, click on the Status bar.

3. Double-click the desired 3D model in the Sheet Browser to open it in the Scene View.

4. Use the Sheet Browser to select all 3D models that you want to append to the currently
open model.
Tip: To select multiple model, use SHIFT and CTRL keys.

5. Right-click the selection, and click Append to Current Model.
Note: The Undo command is not available.

5.5.2 To merge files
1. Click New on the Quick Access toolbar.
Open the first of the files with the review markup.
Click Home tab Project panel Merge.
In the Merge dialog box, use the Files of Type box to select the appropriate file type
(NWD or NWF), and navigate to the folder where your files you want to merge are
located.
5. Select the required files, and click Open.
Tip: To select multiple files, use SHIFT and CTRL keys.

Pobd

Command entry: CTRL + M
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5.6 Combining Files in Navisworks Example

5.6.1 Importing Advance Steel and Revit into Navisworks
1. Use Revit to create a foundation. Before beginning to model, choose a specific origin.
This origin will be the point at which all models will line up in Navisworks. Having an
identical origin in all programs means that each appended model will overlay the other
one exactly.

Figure 5-1: Revit Foundation

2. Using the Add-ins Tab and the External Tools dropdown, export the Revit model into
Navisworks. It will automatically be exported as an NWC.

Figure 5-2: Navisworks Foundation
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3. Go to Advance Steel and create the building’s steel framework. Ensure that the origin
matches the origin of the Revit model.

Figure 5-3: Advance Steel Framework

4. Hide all unwanted elements. Use the Export & Import Tab and the Export to
Navisworks command to place the model in Navisworks. It will open as a DWF.

Figure 5-4: Navisworks Framework

5. Open the Navisworks model of the framework and see the object properties such as
section, weight, and part mark have been transferred from Advance Steel. Then save
the model as an NWF.
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6. Open the Navisworks model of the foundation. Use the Append tool to open the
Navisworks model of the framework in the same space. Both models will appear
together in Navisworks. To combine the models into one, save the appended model as a
NWD.

Figure 5-5: Fully Appended Model
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6 Navigating in a Model

In this chapter:

Looking at the navigation bar

Rotating your model with the Orbit tool
Looking around your model

Using the Gravity tool

Using the ViewCube
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6.1 Looking at the navigation bar

The navigation bar is a user interface element where you can access both unified and product-
specific navigation tools.

Unified navigation tools (such as Autodesk® ViewCube®, 3Dconnexion®, and Steering
Wheels®) are those that can be found across many Autodesk products. Product-specific
navigation tools are unique to a product. The navigation bar floats over and along one of the
sides of the Scene View.

You start navigation tools by clicking one of the buttons on the navigation bar or selecting one of
the tools from a list that is displayed when you click the smaller portion of a split button.

1. View Cube Indicates the current orientation of a model, and is used to reorient the
current view of a model. Clicking this button displays the View Cube in the Scene View
when it's not visible.

2. Steering Wheels Collection of wheels that offer rapid switching between specialized

navigation tools.

Pan tool. Activates the pan tool and moves the view parallel to the screen.

4. Zoom tools. Set of navigation tools for increasing or decreasing the magnification of the
current view of the model.

5. Orbit tools. Set of navigation tools for rotating the model around a pivot point while the
view remains fixed.

6. Look tools. Set of navigation tools for rotating the current view vertically and
horizontally.

7. Walk and Fly tools. Set of navigation tools for moving around the model and controlling
realism settings.

8. Select tool. Geometry selection tool. You cannot navigate through your model during
geometry selection.

9. 3Dconnexion. Set of navigation tools used to reorient the current view of a model with a
3Dconnexion 3D mouse.

Note: In a 2D workspace, only the 2D navigation tools (such as 2D Steering Wheels,
Pan, Zoom, and the 2D Mode 3Dconnexion tools) are accessible.

w

2.2 Walking through your model

Set of navigation tools for moving around the model and controlling realism settings. These
tools are not available in a 2D workspace.

The following tools are available:

» Walk. Moves through a model as if you were walking through it.
* Fly. Moves through a model like in a flight simulator.

6.1.1 Walk

The tool is activated by clicking Walk in the Walk/Fly drop-down on the navigation bar. By
default, the tool behaves like the Walk tool on the Steering Wheels. You can customize the tool
options in the Options Editor. You can also switch back to the legacy Walk mode.

6.1.2 Fly
The tool is activated by clicking Fly in the Walk/Fly drop-down on the navigation bar.
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6.2 Rotating your model with the Orbit tool

Set of navigation tools for rotating the model around a pivot point while the view remains fixed.
These tools are not available in a 2D workspace.

The following orbit tools are available:

» Orbit. Moves the camera around the focal point of the model. The up direction is always
maintained, and no camera rolling is possible.

* Free Orbit. Rotates the model around the focal point in any direction.

» Constrained Orbit. Spins the model around the up vector as though the model is sitting
on a turntable. The up direction is always maintained.

6.2.1 Orbit

The tool is activated by clicking Orbit in the Orbit drop-down on the navigation bar. It behaves
the same way as the Orbit tool on the Steering Wheels. You can use the Options Editor to
switch back to the legacy Orbit mode.

6.2.2 Free Orbit
The tool is activated by clicking Free Orbit in the Orbit drop-down on the navigation bar. You
can use the Options Editor to switch back to the legacy Examine mode.

6.2.3 Constrained Orbit
The tool is activated by clicking Constrained Orbit in the Orbit drop-down on the navigation bar.
You can use the Options Editor to switch back to the legacy Turntable mode.

6.3 Looking around your model

6.3.1 Pan Tool
The pan tool moves the view parallel to the screen.

The tool is activated by clicking Pan @ on the navigation bar. Pan behaves the same way as
the pan tool available on the Steering Wheels.

6.3.2 Look Tools
Set of navigation tools for rotating the current view vertically and horizontally. These tools are
not available in a 2D workspace.

The following look tools are available:

e Look Around @ Looks around the scene from the current camera location.

* Look At @ . Looks at a particular point in the scene. The camera moves to align with
that point.

V4

* Focus Looks at a particular point in the scene. The camera stays where it is.

Look Around
The tool is activated by clicking Look Around in the Look drop-down on the navigation bar. It

behaves the same way as the Look tool available on the Steering Wheels.
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Look At
The tool is activated by clicking Look At in the Look drop-down on the navigation bar. It behaves

the same way as the Steering Wheels Look tool when you press and hold the SHIFT key.

Focus
The tool is activated by clicking Focus in the Look drop-down on the navigation bar.

6.4 Using the Gravity tool

To toggle gravity

"
When using the Walk tool, click Viewpoint tab » Navigate panel » Realism drop-down ﬁ
» Gravity check box.

Command entry: CTRL + G

Note: This function only works in connection with collision.
Where collision gives you mass, gravity gives you weight. As such, you (as the collision volume)
will be pulled downwards whilst walking through the scene.

Note: Gravity can only be used with the Walk navigation tool.
This allows you to walk down stairs, for example, or follow terrain.

6.5 Using the ViewCube

The ViewCube tool is a persistent, clickable, and draggable interface that you use to switch
between views of your model.

When you display the ViewCube tool, by default it is shown in the top-right corner of the Scene
View over the model in an inactive state. The ViewCube tool provides visual feedback about the
current viewpoint of the model as view changes occur. When the cursor is positioned over the
ViewCube tool, it becomes active. You can drag or click the ViewCube, switch to one of the
available preset views, roll the current view, or change to the Home view of the model.

dOL o
LEFT

Figure 6-1 View Cube

Tip: When the navigation bar is linked to the ViewCube, both can be moved around the Scene
View.

6.5.1 Control the Appearance of ViewCube

The ViewCube tool is displayed in one of two states: inactive and active. When the ViewCube
tool is inactive, it appears partially transparent by default so that it does not obscure the view of
the model. When active, it is opaque and may obscure the view of the objects in the current
view of the model.
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In addition to controlling the opacity level of the ViewCube when it is inactive, you can also
control its size, and the display of the compass. The settings used to control the appearance of
the ViewCube are located in the Options Editor.

6.5.2 Use the Compass

The compass is displayed below the ViewCube tool and indicates which direction North is
defined for the model. You can click a cardinal direction letter on the compass to rotate the
model, or you can click and drag one of the cardinal direction letters or the compass ring to
interactively rotate the model around the pivot point.

<7 \
S

Figure 6-2 Compass View of View Cube

6.5.3 Drag or Click ViewCube

When you drag or click the ViewCube tool, the view of the model reorients around a pivot point.
The pivot point is displayed at the center of the object that was last selected before using the
ViewCube tool.
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7 Working W|th Vlewpomts

In this chapter:
Saving a viewpoint
Choosing render styles
Changing the background
Slicing your model using sectioning

Getting rid of lines and text
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7.1 Saving a viewpoint

Viewpoints are snapshots taken of the model as it is displayed in the Scene View. They can be

taken by clicking the Save Viewpoint e} button under the Viewpoint Tab. Importantly,
viewpoints can be used for more than just saving information about the view of the model. For
example, they can be annotated with redlines and comments, allowing you to use viewpoints as
a design review audit trail. Viewpoints can also be used as links in the Scene View, so that
when you click on and zoom to the viewpoint, Autodesk Navisworks also displays the redlines
and comments associated with it.

The viewpoints, redlines and comments are all saved into an NWF file from Autodesk
Navisworks, and are independent of the model geometry. So, if the native CAD files are
changing, the saved viewpoints remain the same, appearing as an overlay on top of the base
layer of model geometry. This enables you to see how the design has evolved. See Review
Your Model for more information on links, comments and redlines and Native File Formats for
more information on the NWF file format.

Viewpoints encompass a range of different information about the view of the model, navigation
settings, and annotations in the form of redlines and comments. See Default Viewpoint Options
for more information.

7.1.1 View of the Model
» Camera position, projection mode, field of view and orientation
» Lighting mode, render mode and toggles for the display of different geometry types
(surfaces, lines, points)
» Sectioning configuration

Additionally, the following item overrides can be saved with the viewpoint (this is optional):

» Visibility (hidden / required)
» Appearance (color and transparency)

7.1.2 Navigation
* Linear and angular speeds of motion
* Realism settings (collision, gravity, third person, crouch)
* The currently selected navigation tool

7.1.3 Annotations
 Redlines
« Comments

7.1.4 Saved Viewpoint Window

The Saved Viewpoints window is a dockable window that enables you to create and manage
different views of your model so that you can jump to preset viewpoints without having to
navigate each time to reach an item.

Viewpoint animations are also saved with the viewpoints, as they are simply a list of viewpoints
treated as keyframes. In fact, viewpoint animations can be made by dragging preset viewpoints
onto an empty viewpoint animation. You can organize your viewpoints and viewpoint animations
using folders.
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Icons are used to represent different elements:

O represents a folder which may contain all other elements (including other folders).
& represents a viewpoint saved in orthographic mode.

D represents a viewpoint saved in perspective mode.

o represents a viewpoint animation clip.

&< represents a cut inserted into a viewpoint animation clip.
You can select more than one viewpoint by either holding down the CTRL key and left-clicking,
or by left-clicking the first item, and then clicking the last item while holding down the SHIFT key.

You can drag viewpoints around the Saved Viewpoints window, and reorganize them into
folders or animations.

There are no buttons on this window, and commands are invoked through context menus.

Through these menus, you can save and update viewpoints, create and manage viewpoint
animations, and create folders to organize these viewpoints and viewpoint animations. You can
also drag and drop viewpoints or viewpoint animations onto viewpoint animations or folders.
Holding down the CTRL key during this operation will copy the element being dragged. This
allows complex hierarchies of viewpoint animations and folders to be easily composed.

Viewpoints, folders and viewpoint animations can all be renamed by slow clicking (clicking and
pausing without moving the mouse) the element, or clicking it and pressing F2.

Saved Viewpoints X

#-{] 3D View

= u Animation
1) view
@ View (1)
@ View (2)
@ View (3)
1) view (4)

Figure 7-1: Saved Viewpoints Window

7.2 Choosing render styles

Use the Autodesk Rendering window to access and work with materials libraries, lighting, and
environment settings.
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The Autodesk Rendering window is a dockable window, which is used to set up materials and
lights in your scene, as well as environments settings, and render quality and speed. It can be

o
accessed by pressing the Autodesk Rendering & button.

The Autodesk Rendering window contains the Rendering toolbar, and the following tabs:

Materials. Allows you to navigate and manage material collections, known as libraries,
provided by Autodesk, or create custom libraries for specific projects. Default material
library Includes a variety of materials, which can be selected and applied to your model.
You can also use this tab to create new materials, or customize existing materials.
Material Mapping. Allows you to adjust the orientation of the texture to fit the shape of
the object. This feature is recommended for advanced users only.

Lighting. Allows you to view the lights already added to the model, and customize the
lighting properties.

Environments. Allows you to customize the Sun, the Sky, and Exposure properties.
Settings. Allows you to change the Render Style presets. You can select from a range
of default quality presets or customize your own render settings.

Autodesk Rendering v X
[Qﬁﬁeate Light ~ I 4 I 11:1 Sun | @&} Exposure
Materials | Material Mapping l Lighting l Environments l Settings
l:ffs'c’ QI
Document Materials E =
Name ~ Category
- Flat - Gray 1 Concrete: Cast-In-Place
A v ) Autodesk Library v Bi=-
£ Autodesk Lib... (3 Name ~ Category
T ol o
pamiceiamic . 1.5in Square - Brown Ceramic: Tile
» M Concrete
T Default . 1.5in Square - Medium Blue = Ceramic: Tile
» M Fabric . 1.5in Square - Slate Blue Ceramic: Tile
[
 Finish . 1.5in Square - Tan Ceramic: Tile
» M Flooring . . .
» T Glass M 12in Non-Unii...r - Burgundy Masonry: Brick
T Liquid . 12in Running - Burgundy Masonry: Brick
>l Masonry M 12in Uniform...nning - Gray Masonry: Brick
» T Metal p— N
T Metallic Paint ] Tin Square - Ivory Ceramic: Tile
& Mirror i 1in Squares - Mosaic Blue Ceramic: Tile
"l Miscellaneous B 1in Squares - Mosaic Gray  Ceramic: Tile
T Paint i Jins Sal c ic: Til
T Plastic . in Square - Salmon eramic: Tile
T Roofing [l 2in Squares - Beige Ceramic: Tile
"a Siding i 3in Octagons - Tan Ceramic: Tile
T Sitework =
3in Octagons - White Ceramic: Tile
» T Stone e 9
M Stucco B 3in Square - Terra Cotta Ceramic: Tile
T Wall Covering [ 3in Squares - Cozy Pink Ceramic: Tile
» Tl Wall Paint ~ = - S
3in Squares - Light Yellow  Ceramic: Tile
» T Wood k:] < Z
»EJ Autodesk Ad... @ + K 3in Squares - White Ceramic: Tile .
g~

Figure 7-2: Autodesk Rendering Window

Page 70



AUTODESK REVIT & NAVISWORKS 2018 TRAINING GUIDE
FOR ADVANCE STEEL USERS

7.3 Changing the background

Use this dialog box to choose a background effect to use in the Scene View

7.3.1 Mode
Selects the type of background effect. Choose from:

* Plain
» Graduated
* Horizon
Note: Horizon mode and the associated colors are only available for 3D models.
7.3.2 Color

Sets the color for a plain background.

7.3.3 Top Color
Sets the top color in a graduated background.

7.3.4 Bottom Color
Sets the bottom color in the graduated background.

7.3.5 Sky Color
Sets the sky color (top) in a horizon background. This option is available for 3D models only.

7.3.6 Horizon Sky Color
Sets the sky color (bottom) in a horizon background. This option is available for 3D models only.

7.3.7 Horizon Ground Color
Sets the ground color (top) in a horizon background. This option is available for 3D models only.

7.3.8 Ground Color
Sets the ground color (bottom) in a horizon background. This option is available for 3D models
only.

Ribbon: View tab » Scene View panel » Background

Shortcut menu: Right-click a blank area in the scene, and click Background on the context
menu.

Figure 7-3: Backgrounds — Plain, Graduated, Horizon (Below Horizon)
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7.4 Slicing your model using sectioning

Autodesk Navisworks enables you to turn on sectioning for the current viewpoint and to create
cross sections of your model in a 3D workspace. The sectioning functionality is not available for
2D sheets.

A cross section is a cut-away view of a 3D object that enable you to see inside it. You can turn
sectioning on and off for the current viewpoint by clicking Viewpoint tab » Sectioning panel »

Enable Sectioningl*/gu. When the sectioning is turned on, the Sectioning Tools contextual tab is
automatically displayed on the ribbon.

There are two sectioning modes available from the Sectioning Tools tab »
Mode panel: Planes and Box.

Planes LD mode allows you to make up to six sectional cuts in any plane while still being able
to navigate around the scene, enabling you to see inside models without hiding any item. By
default, section planes are created through the center of the visible area of the model.

7.5 Getting rid of lines and text

7.5.1 To delete text
Right-click the text you want to delete, and click Delete Redline on the context menu.

7.5.2 To erase redlines
1. Click Viewpoint tab » Save, Load & Playback panel » Saved Viewpoints drop-down,
and choose the viewpoint that you want to review.

Y,
Click Review tab » Redline panel » Draw drop-down, and click Erase - "f
Drag a box over the redline you want to delete, and release the mouse.

SR
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8 The Review Tab

In this chapter:

Getting measurements
Finding the shortest distance between objects

Creating redlines
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8.1 Getting measurements

To access the tools, click Review tab Measure panel on the ribbon.

8.1.1 Measure Tool

0 =2 Measures the distance between two points.

<,

0 = Measures the distance between a base point and various other points.

0 =2 Measures a total distance between multiple points along a route.

o——o
o——o

o ==F Calculates the sum total of several point-to-point measurements.

0 =3 Calculates an angle between two lines.

0 @3 Calculates an area on a plane.

e
0 =2 Measures the shortest distance between two selected objects.
)
o] & Clears all measuring lines in the Scene View.
o] 2 Enables you to move or rotate an object.
o] "’\ Converts the endpoint markers, the lines, and any displayed measurement

values into redlines.

8.2 Finding the shortest distance between objects

Measure tools enable you to measure between points on items in the model. All measurements
are made in display units. The measure tools are available from Review tab Measure panel.

Using measure tools is mutually exclusive to using navigation tools (see Product-Specific
Navigation Tools), so that when you are measuring you cannot navigate and vice versa.

After selecting a measuring tool, select the points on the model that need to be measured.
Navisworks will then show the information it has collected from that measurement.

Figure 8-1: Measure Tool

EEEED

To clear a measurement, select Clear Measurement #in the Measure Panel.
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8.3 Creating redlines

The Redline Tools panel on the Review tab enables you to markup viewpoints and clash results

with redline annotations. When you create a redline, the associated viewpoint is automatically
saved.

A Q /GColor H -

Draw Erase —Thlckness 3 .

v
v

Redline

Figure 8-2: Reline Panel

The Thickness and Color controls enable you to modify the redline settings. These changes do
not affect already drawn redlines. Also, thickness only applies to lines; it does not affect redline
text, which has a default size and weight and cannot be modified.

Figure 8-3: Redline Markup

You can also convert measurements to redlines with the Convert To Redline tool EL\ .
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9 Dealing with Objects

In this chapter:

Selecting objects

Overriding color, transparency, and a transform
Hiding and turning on objects

Moving items

Rotating items

Scaling items

Adding links

Viewing properties and adding fields

Switching back to Revit

Holding objects
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9.1 Selecting objects

With large models, it is potentially a very time-consuming process to select items of interest.
Autodesk Navisworks makes this a much simpler task by providing a range of functions for
quickly selecting geometry both interactively and by searching the model manually and
automatically.

9.1.1 Interactive Geometry Selection

In Autodesk Navisworks, there is a concept of an active selection set (the currently selected
items, or the current selection) and saved selections sets. Selecting and finding items makes
them part of the current selection, so you can hide them or override their colors. At any time, the
current selection can be saved and named for retrieval in later sessions with the Save

Selection [(Eﬂ button.

Selecting items makes them part of the current selection, so you can hide them or override their
colors.

You can use several methods to interactively select items into the current selection. You can
use the drop-down list in the Selection Tree, select items directly in the Scene View with the
Select and Select Box tools, and you can select other items with similar properties to an existing
selection using the selection commands under the Home Tab on the Select and Search Panel.
Note: Right-clicking any item in the Selection Tree or Scene View opens a context menu.

You can also customize the level at which you select items (selection resolution), and modify
the highlighting method for the items selected in the Scene View.

Selection Tree ® X

Standard v

B(g) Fully Appended Model NWD.nwd
Q 02_Revit_Full-Structure- Foundations Only.nw:
22 Floors
22 Floor
2:; 6" Concrete

® ¢ Floor

8 Structural Columns

8 Concrete-Rectangular-Column
875 PED 18" x 18"

08
® @ Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# @ Concrete-Rectangular-Column
# @ Concrete-Rectangular-Column
® & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
® @ Concrete-Rectangular-Column
® @ Concrete-Rectangular-Column
® @ Concrete-Rectangular-Column
® @ Concrete-Rectangular-Column
® @ Concrete-Rectangular-Column

%3 Structural Foundations

B[g) Drawing1.dwf

@& Beams (22)

®& Columns (15)

©¢3 HELP LINES (13)

@@ Plates (87)

Figure 9-1: Selection Tree — Column Selected
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[% [@] C/% @ E @, Find items

] Quick Find Q
Select Save Select Select . Selection
N Selection All Same Tree [(b]Sets N %

Select & Search ~

Figure 9-2: Home Tab - Select & Search Tools

9.2 Overriding color, transparency, and a transform

9.2.1 Manipulate Object Attributes

In Autodesk Navisworks, you can manipulate objects’ transforms (translation, rotation, and
scale), and also change appearance (color and transparency) of objects. All object manipulation
is carried out in the Scene View.

Any changes that you make to object attributes are considered to be global, (as if they’d been
changed in the original CAD model), and can be saved with Autodesk Navisworks files. You
have an option of resetting object attributes back to the state they were in when imported from
the original CAD files.

To transform objects, you can use three visual manipulation tools, or gizmos, available from the
Item Tools Tab, Transform Panel. You can also transform objects numerically.

Ly | l O
‘3" O D ﬁ]ﬁ }1‘5".:‘-95"&:‘.:‘/ 0 % BEn

Move Rotate Scale Reset OCoIor: Dv Reset
Transform Appearance

Transform ~ Appearance

Figure 9-3: Item Tools — Transform and Appearance Panels

To get a clearer view of objects as you manipulate them, you can use the Options Editor to
adjust the way in which the current selection is highlighted. For more information, see Set
Highlighting Method.

9.2.2 Using Measure Tools to Transform Objects
You can use the Measure Tools functionality to move and rotate the currently selected objects.
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9.2.3 Examples of Overrides

Figure 9-4: Color Change Override

Figure 9-4: Rotate Change Override

9.3 Hiding and turning on objects

Autodesk Navisworks provides tools that can be used to hide and display objects or groups of
objects. Hidden objects are not drawn in the Scene View.

9.3.1 Hide Selected Objects

You can hide the objects in the current selection so that they are not drawn in the Scene View.
This is useful when you want to remove specific parts of the model. For example, when you
walk down the corridor of building, you may want to hide a wall that occludes your view of the

next room.
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9.3.2

Hide Unselected Objects

You can hide all items except those currently selected so that they are not drawn in the Scene
View. This is useful when you only want to see specific parts of the model.

9.3.3

1.

2.

To hide selected objects

In the Scene View, select all items you want to hide.
=

Click Home tab » Visibility panel » Hide ==,

The selected objects are now invisible.

/7‘

Clicking Hide l—:U' again displays the invisible objects.

9.4 Moving items

9.4.1

1.
2.
3.

9.4.2

N

To move an object numerically
Select the object you want to move in the Scene View.
Click the Item Tools tab, and slide out the Transform panel.
Type in numerical values into the manual entry boxes to move the object by the amount
entered:
» Position X, Y, Z represent translation distance in the current model unit.
» Transform Center X, Y, Z represent the translation center point.

To move an object with a measure tool
Select the object you want to move.

Click Review tab » Measure panel » Measure drop-down > Point Line ===,

Click the selected object to create the first point. This is the start point from which the
repositioning will be calculated.

Click the second point in the scene. This is the point where the object will be moved to.
There is now a line connecting the start point and the end point in the Scene View.

If you want to be able to move the object several times, create more points in the scene.
Note: You can only select a point on another object in the scene. Selecting a point in
'space’ is not a valid option. To reposition an object into 'space', you can either use a
translation gizmo or, if you know the distance by which the object is to be moved, by
overriding its transform.

Slide out the Measure panel, and click Transform Selected Items 2 to move the object
to the second point. If you have multiple points in the scene, each time you

click Transform Objects the selected object is moved to the next point.

9.5 Rotating items

9.5.1

1.

2.
3.

To rotate an object with gizmo
Select the object you want to rotate in the Scene View.

Click ltem Tools tab » Transform panel » Rotate O :
Use the gizmo to rotate the currently selected object:
» Before you can rotate the currently selected objects, you need to position the
origin (center point) of the rotation. To do this, place the mouse over the arrow at

the end of the desired axis. When the cursor changes to @ drag the arrow on
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9.5.2

9.5.3

SR

the screen to increase/decrease the translation along that axis. This will move
the gizmo itself.

Dragging the ball in the middle of the rotate gizmo enables you to move it
around, and snap it to points on other geometry objects.

» Once the rotate gizmo is positioned correctly, place the mouse over one of the
curves in the middle, and drag it on the screen to rotate the selected objects. The
curves are color-coded, and match the color of the axis used to rotate the object
around. So, for example, dragging the blue curve between the X and Y axes,
rotates the objects around the blue Z axis.

» To rotate the orientation of the gizmo to an arbitrary position, hold down the
CTRL key while dragging one of the three curves in the middle.

» To snap the gizmo to other objects, hold the CTRL key while dragging the ball in
the middle of the gizmo.

To rotate an object numerically
Select the object you want to rotate in the Scene View.
Click the Item Tools tab, and slide out the Transform panel.
Type in numerical values into the manual entry boxes to move the object by the amount
entered:
* Rotation X, Y, Z represent degrees of rotation in the current model unit.
» Transform Center X, Y, Z represent the rotation center point.

To rotate an object with a measure tool
Select the object you want to move.

Click Review tab » Measure panel » Measure drop-down » Measure Angle ===,

To rotate the object, click three points on the selected object to determine how the object
is to be rotated.

Slide out the Measure panel, and click Transform Selected Items 2. This rotates the
selected object from position A into position B (as shown in the previous diagram).
Clicking this button again, rotates the object from position B into position C.

9.6 Scaling items

9.6.1

1.

2.
3

9.6.2

To resize an object with gizmo
Select the object you want to resize in the Scene View.

Click Item Tools tab » Transform panel » Scale ’ETJ
Use the scale gizmo to resize the currently selected object:

» To resize the objects across a single axis only, use colored arrows at the end of
the axes. To resize the objects across two axes at the same time, use colored
triangles in the middle of the axes. Finally, to resize the objects across all three
axes at the same time, use the ball in the center of the gizmo.

* You can modify the center of scaling. To do this, place the mouse over the ball in
the middle of the gizmo, and hold down the CTRL key while dragging the ball on
the screen.

To resize an object numerically
Select the object you want to resize in the Scene View.
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2. Click the Item Tools tab, and slide out the Transform panel.
3. Type in numerical values into the manual entry boxes to move the object by the amount
entered:
» Scale X, Y, Z represent a scaling factor (1 being the current size, 0.5 half, 2
being double, and so on).
» Transform Center X, Y, Z represent the scaling center point.

9.7 Adding links

You can add links that point to various data sources, such as spreadsheets, webpages, scripts,
graphics, audio and video files and so on. An object can have multiple links attached to it,
although, only one link, called default, is shown in the Scene View. The default link is the link
that you add first, but you can mark a different link as default, if necessary.

9.7.1 To add a link to an object
1. Inthe Scene View, select the desired geometry item.

2. Click Item Tools tab » Links panel » Add Link &+,
3. Inthe Add Link dialog box, enter the name for the link in the Name box.
4. In the Link to File or URL box, type in the full path to the required data source or the URL

address. You can also browse LJ to the folder containing the desired external file.

5. Choose the category for your link from the Category drop-down list. by default, your link
has hyperlink category.

Tip: To create a custom category type, type its name directly into the Category box.
when you save your link, the corresponding user-defined category is automatically
created.

6. Optional: By default, your link is attached to the default center of the item’s bounding
box. If you want to attach your link to a specific point on the selected item, click the Add
button. A cross-hair cursor appears in the Scene View, allowing you to select a point on
the item where the link will be attached to.

Note: If you made a mistake, clicking the Clear All button deletes all attachment points
associated with this link and reverts to the link being attached to the center of the item's
bounding box.

7. Click OK.

9.7.2 To add several links to the same object

1. Inthe Scene View, select the desired geometry item.

2. Right-click and click LinksAdd Link.

3. Use the Add Link dialog box to add the first link. This is the default link, and it's the only
link that will be visible in the Scene View. You can choose a different default link later, if
necessary.

4. Right-click the object again, and repeat the previous steps to add all required links.

9.8 Viewing properties and adding fields

9.8.1 To examine object properties
1. Select the object of interest in the Selection Tree, or in the Scene View.

2. Open the Properties window under the Home Tab, and use the tabs to navigate
between the available property categories.
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Note: If more than one object is selected, the Properties window only shows the number
of selected items, and doesn’t show any property information.

9.8.2 To add a custom property tab
1. Open the Properties window.
2. Select the object of interest in the Scene View or on the Selection Tree.
3. Right-click the Properties window, and click Add New User Data Tab. The new property
category is added for the currently selected object. By default, the tab is called User
Data.

9.9 Switching back to Revit

1. For Revit or products based on it, open the product in the usual manner, and initialize
the Navisworks SwitchBack add-in:
a. Open any existing project, or create a new one.
b. Click Add-Ins tab » External Tools » Navisworks SwitchBack to enable it. You
can now close the project, but don't close Revit.

2. Return to Autodesk Navisworks and open the desired file. As long as you are working
with an NWC file exported from Revit, or a saved NWF or NWD file, you can SwitchBack
to Revit.

3. Select an object in the Scene View, and click Iltem Tools tab » SwitchBack panel »

SwitchBack G Revit will load the relevant project, find and select the item, and zoom
to it. If SwitchBack was unsuccessful with the selected object, and you receive an error
message, try selecting further up the Selection Tree in Autodesk Navisworks.

Tip: Alternatively, in the Clash Detective window, on the Results tab, you can click

the SwitchBack button. The Clash Detective feature is available for Autodesk
Navisworks Manage users only.

Note: If you try to use SwitchBack and the RVT file is not in the same location as when it was
saved, a dialog box will appear asking you to browse to the RVT file. When

using SwitchBack for the first time to load a Reuvit file, a 3D view based on the chosen projection
view mode is created inAutodesk Navisworks. The next time SwitchBack is used to load a Revit
file, the same projection view mode loads, unless the projection view mode is changed

in Autodesk Navisworks.

9.10Holding objects

1. Select the objects you want to hold either in the Scene View or in the Selection Tree.

2. Click Item Tools tab » Hold panel » Hold L
The selected objects are now held and will move with you through the model when you
use navigation tools, such as Walk, Pan and so on.

To release the held objects, click Hold Cw on the ribbon again.
If you want to reset the objects to their original position, click Iltem Tools tab »

W

Transform panel » Reset Transform "

Page 83



AUTODESK REVIT & NAVISWORKS 2018 TRAINING GUIDE
FOR ADVANCE STEEL USERS

Page 84



10 Sorting and grouping

In this chapter:

The Selection Tree
Finding items

Saving selections as a set
Using the Quick Find tool

Using the Selection Inspector
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10.1 The Selection Tree

The Selection Tree 5] is a dockable window, which displays a variety of hierarchical views of
the structure of the model, as defined by the CAD application in which the model was created.

Autodesk Navisworks uses this hierarchical structure to identify object-specific paths (from the
file name down to a particular object).

For Revit 2014 and later (RVT or NWC) files, the model hierarchy can be structured to display
category, family, type and instance below each level, and show the material from which the
Revit object is made. For example, a door may be broken up into constituent parts such as
glass or wood panel.

By default, there are four options on the drop-down list:

» Standard. Displays the default tree hierarchy, including all instancing. The hierarchy can
be sorted alphabetically.

» Compact. Displays a simplified version of the hierarchy on the Standard option, omitting
various items. You can customize the level of complexity of this tree in the Options
Editor.

* Properties. Displays the hierarchy based on the items' properties. This enables simple
manual searching of the model by item property.

» Sets. Displays a list of selection and search sets. If no selection and search sets have
been created, this option is not shown.

Note: The list of the items on the Sets option is exactly the same as the list on the Sets
dockable window.

Additional customized Selection Tree options can be added by using the Autodesk Navisworks
API.

Naming of items reflects the names from the original CAD application, wherever possible. You
can copy and paste names from the Selection Tree. To do this, right-click an item in the
Selection Tree, and click Copy Name on the context menu. Alternatively, you can click an item
in the Selection Tree, and press CTRL + C. The name is now copied to the clipboard.

There are different tree icons representing the types of geometry making up the structure of the
model. Each of these item types can be marked as hidden (gray), unhidden (dark blue) or
required (red).

Note: If a group is marked as hidden or required, then all instances of that group are marked as
hidden or required. If you want to operate on a single occurrence of an item, then you should
mark the instanced group (the level above, or the “parent”, in the hierarchy) hidden or required.

10.2 Finding items

1. On the Selection Tree, click the items where you want to start searching from. For
example, if you want to search the whole model, select the Standard option from the
drop-down list, press and hold CTRL, and click all files that comprise the model. If you
want to limit your search to a selection set, select the Sets option from the drop-down
list, and click the required set.

2. Define a search statement:
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a. Click the Category column, and select the property category name from the drop-
down list, for example, ‘Item’.
b. Inthe Property column, select the property name from the drop-down list, for
example, ‘Material’.
c. Inthe Condition column, select the condition operator, for example, “Contains”.
d. Inthe Value column, type in the property value to search for, for example,
“Chrome”.
e. If you want to make your search statement case-insensitive, right-click it, and
click Ignore String Value Case.
3. Define more search statements, if required.
By default, all statements are ANDed. This means that they all need to be true for an
item to be selected. You can make a statement use OR logic, by right-clicking it and
clicking Or Condition. If you are using two statements, and marked the second one as
ORed, this means that an item will be selected if either of these statements is true.
4. Click the Find All button. The search results are highlighted in the Scene View and the
Selection Tree.

10.3Saving selections as a set

The Sets window @55 ~ is a dockable window, which displays both selection sets and search
sets available in your Autodesk Navisworks file.

The selection sets are identified by this icon: ®, and the search sets are identified by this

icon: “.

Note: The list of the items on the Sets window is exactly the same as the list on the Sets drop-
down option on the Selection Tree.

You can customize the names of selection and search sets, and add comments. You can copy
and paste names from the Sets window. To do this, right-click an item in the Sets window, and
click Copy Name on the context menu. Alternatively, you can click an item in the Sets window,
and press CTRL + C. The name is now copied to the clipboard.

You can also show the selection and search sets as links in the Scene View. These links are
created automatically by Autodesk Navisworks. Clicking on a link restores the geometry within
the corresponding selection or search set to the active selection, and highlights it in the Scene
View and on the Selection Tree.

You can use the buttons in the Sets window to create and manage selection and search sets in
the Autodesk Navisworks file.

10.4Using the Quick Find tool
1. Click Home tab » Select & Search panel.

2. Inthe Quick Find text box =~ < , type in the string to search for in all item’s
properties. This can be a word or a few words. The search is not case-sensitive.

3. Click Quick Find{'. Autodesk Navisworks finds and selects the first item in the Selection
Tree that matches the entered text, selects it in the Scene View, and stops the search.
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4. To find more items, click Quick Find<" again. If there are any more items that match the
entered text, Autodesk Navisworks selects the next one in the Selection Tree, selects it
in the Scene View, and stops the search. Subsequent clicks find next instances.

Command entry: To open the Quick Find dialog box: CTRL + F. To Find Next: F3

10.5Using the Selection Inspector

The Selection Inspector 2 is a dockable window which can be accessed in the Home Tab,
which displays a list of all the selected objects and the Quick Properties associated with those
objects.

You can inspect a selection from the Selection Tree or Scene View. Alternatively, choose a
Selection Set or a Search Set. You can then zoom the selection to display it within the model, or
modify it by deselecting objects and adding property definitions.

When you save a selection, it appears in the Sets window. You can then rename your selection
set. See Sets Window for more details.

All the objects that are visible within the Selection Inspector window may be exported into a
CSV file. You must deselect objects if you wish to exclude them from the exported file.
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11 Clash Detection

In this chapter:

Creating a clash test and setting rules

Selecting objects to clash and adding clearances
Running the clash

Resolving and reducing clashes

Grouping and assigning clashes

Creating report; Viewpoints

Creating reports: HTML
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11.1 Creating a clash test and setting rules

Exported clash tests can be used as a basis to define custom clash tests. If you have a common
set of clash tests that you reuse on multiple projects, you can turn them into a custom clash test.
Once installed as a custom clash test, all the tests can be selected and run directly from the
Select Tab. The results from all tests are combined and presented as the results of the custom
clash test. The name of each individual test in the custom clash test is displayed in the
Description field of the results.

Custom clash tests are an excellent way to roll out a standardized set of tests across an
organization. They allow the expertise of “power” users to be reused by everyone. They can
also be seen as a way of implementing object intelligence. For example, a custom clash test
could be written that checked for compliance with a local building code based on object
information and properties defined in a particular CAD system.

11.1.1 To define and use a custom clash test

1. Export Clash Tests to an XML file. The name of the file is used as the default name for
the custom test.

2. If you want, change the name of the custom test by editing the XML file directly. The top-
level element in the XML file is called “batchtest’. The name of the custom test as
displayed to the user is defined by the “name” attribute. The name of the custom test as
saved in a file is defined by the “internal name” attribute.

3. Toinstall the custom test, copy the exported XML file to the custom_clash_tests folder of
one of the Autodesk Navisworks search directories, for example: C:\Documents and
Settings\All Users\Application Data\Autodesk Navisworks 2018\custom_clash_tests. See
Search Directories for more information.

4. Restart Autodesk Navisworks. On startup, Clash Detective checks these search
directories for custom clash tests.

5. To use the custom test, open the Clash Detective window, and click the Select tab.

6. Select your custom test from the Type drop-down box.

7. Click the Start button. All other options and rules are specified by the custom test.

11.2 Selecting objects to clash and adding clearances
1. If the Clash Detective window is not already open, click Home tab Tools panel Clash

Detective 7.

Click the Tests panel expand button, and select the test you want to configure.

3. Click the Select tab.
There are two identical panes in this tab called Selection A and Selection B. These
panes contain tree views of two sets of items that will be tested against each other
during the clash test, and you need to select items in each. You can select the items by
choosing an option from the drop-down list for each selection tree and manually
selecting items from the tree hierarchies. Any selection sets in the scene are also
available from the drop-down list, which is a quick and useful method of setting up items
across sessions (see Interactive Geometry Selection).
You can also transfer the current selection to one of the selection panes by selecting
items in the usual way in the Scene View or Selection Tree and clicking the appropriate
Use Current Selection button.

N
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4.

5.

Optional: Select the appropriate Self Intersect button to test the corresponding set for
self-intersection, as well as intersection against the other set.

Optional: You can include the clashing of points, lines, or surfaces in your test.
Underneath each window there are three buttons that correspond to surfaces, lines and
points. To toggle a button, click it.

So, for example, if you want to run a clash test between some surface geometry and a
point cloud, you can set up the geometry in the Selection A pane, and click the Point
Cloud button under the Selection B pane. The Surface button under the Selection A
pane is toggled on by default. Additionally, you could set the clash Type to Clearance
with a Tolerance of 1 meter.

Note: If the Type is set to Hard, lines and surfaces will actually need to intersect with any
points to register a clash.

Clash Detective v x

Test 1 Last Run: Thursday, June 1, 2017 11:36:05 AM

Clashes - Total: 0 (Open: 0 Closed: 0)

Name Status Clashes I New Active | Reviewed || Approved Resolved
Test 1 Done o 0 o 0o 0 0

I [F Add Test ||| ResetAll | CompactAll | Delete All B~

Rules Select | Results l Report

Selection A Selection B

Standard ~ Standard ~

02_Revit_Full-Structure.nwc
@3 Floors

ncrete-Rectangular-Column
4W Shapes-Column

@¢5 Structural Foundations

@2 Structural Framing

[B]/]] ] [8]% [B]/] =] (0] [@]as

3 in
Link: | None v | Step(seq: 0.1 Run Test

[¥] Composite Object Clashing

Figure 11-1: Clash Detective

11.3 Running the clash

1. If the Clash Detective window is not already open, click Home tab » Tools panel »
F 3
Clash Detectivewcpﬂ.
2. Click the Tests panel expand button and select the test you want to run.
3. Click the Select tab and set the required test options.
4.

Once the Selection A and Selection B items are selected, and the clash type and
tolerance defined, click the Run Test button to start the test running.
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Note: The progress bar shows how far through the test Clash Detective has got. If you wish to

stop the test at any time, press the Cancel button. All clashes found up until the interrupt will be
reported, and the test will be saved with a Partial status. When the test is complete

the Results tab will open displaying the results of the test, unless there were no clashes found.

11.4 Resolving and reducing clashes

There are four default clash test types for you to choose from:

» Hard. Choose this option if you want the clash test to detect actual intersections
between geometry.

» Hard (Conservative). This option performs the same clash test as Hard, however, it
additionally applies a conservative intersection method.

» Clearance. Choose this option if you want the clash test to check for geometry within a
specific distance from other geometry (see tolerance for more information). You can use
this type of clash when, for example, pipes need to have space for insulation around
them.

Note: Clearance clashes are not the same as “soft” clashes. Clearance clashes detect
for static geometry coming within a distance of other geometry, whereas soft clashes
detect potential clashes between moving components. Clash Detective supports soft
clash checking when you link it to Object Animation.

» Duplicates. Choose this option if you want the clash test to detect for duplicate
geometry. You can use this type of clash test to check a model against itself to ensure
the same part has not been drawn, or referenced twice, for example.

11.5 Grouping and assigning clashes

11.5.1 To group clashes
1. On the Results tab, select all clashes you want to group together and click Group.
2. Type in a new name for the group, and press Enter.
Note: Clash groups are identified with the icon. When clashes are grouped, they are
treated as a single clash in the count at the top of the Clash Detective window. Each
clash group is counted as a single clash unless no clashes have been added to it, in
which case it will not be included in the count.

When you click the created clash group, the two panes in the Items panel show all the clashing
items contained within that clash group, and all corresponding clashes are shown in the Scene
View.

11.5.2 To create a clash group

#

1. Click New Group [] on the Results tab. A new group called New Group X is added
above the currently selected clash (or at the top of the list if nothing is selected).

2. Type in a new name for the group, and press Enter.
Note: Clash groups are identified with the = icon.

3. Select clashes you want to add to this group, and drag them into the group.
Note: When clashes are grouped, they are treated as a single clash in the count at the
top of the Clash Detective window. Each clash group is counted as a single clash unless
no clashes have been added to it, in which case it will not be included in the count.
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4.

When you click the created clash group, the two panes in the Items panel show all the
clashing items contained within that clash group, and all corresponding clashes are
shown in the Scene View.

Clash Detective v X

Test 1 Last Run: Thursday, June 1, 2017 11:44:54 AM
Clashes - Total: 14 (Open: 14 Closed: 0)

Name Status Clashes || New Active I Reviewed = | Approved = Resolved
Test 1 Done 14 14 0 0 0 0o
| R AddTest | | ResetAll | CompactAll | Delete All | L@_-}
Rules | Select | Results | Report
|[ “| New Group M j 8 Assign l @ SHNone v | [ [spt | €3 Re-run Test
Name (@103 Status Level Grid In... Found Highlighting
4 [ New Group o2 Tor.. :44:54 01-06-2 [remio [remz )| &
®Clash1 (3 New v L02TOP.. B-4  11:44:54 01-06-2 Use item colors g
@ Clash2 New v L01GRO... B6-4  11:44:54 01-06-2 Highlight all clashes "53
@ Closh3 New v L01GRO... B6-4  11:44:54 01-06-2 —— S
@ Clash4 New v L02TOP.. D-4  11:44:5401-06-2 - T
@ Clashs New v L02TOP.. D-3  11:44:54 01-06-2 ent dimming
® Clash6 New v L02TOP... D-2 11:44:54 01-06-2 [[] Auto reveal ‘
@ Clash? New v L02TOP.. A4 11:44:54 01-06-2 Viewpoint
@ Clashg New v L02TOP.. B6-3  11:44:54 01-06-2 Auto-update v
® Clashd New v L02TOP.. C-3  11:44:54 01-06-2 Al S s
@ Clash10 New v L02TOP.. A3 11:44:54 01-06-2 Focus on Clash ‘
® Clash11 New v L02TOP.. C-2  11:44:54 01-06-2 R —
-Simulation
@ Clash12 New v L02TOP.. B6-1  11:44:54 01-06-2 Show simulation ‘
® Clash13 New v L02TOP.. B6-2  11:44:54 01-06-2
® Clashis New v L02TOP. A2 1144554 01-06-2 'V:w eI —
® Clash15 New v L02TOP... A-1 11:44:54 01-06-2 o
@ Clash16 New v L02TOP... A-1 11:44:54 01-06-2 [ view |
@ Clash17 New v LO2TOP.. C-4  11:44:54 01-06-2
® Clash18 New v L02TOP.. C-4  11:44:5401-06-2

| Items
<

Figure 11-2: Results and Clash Groups

11.6 Creating report; Viewpoints

11.6.1
1.
2.

11.6.2

To save viewpoints with clash results manually

In the Clash Detective window, click the Results tab.

Right-click in the Viewpoints column for a clash result and select Save Viewpoint.

The position displayed in the Scene View will be saved as the viewpoint for the clash. If
there is no existing viewpoint thumbnail then a new viewpoint thumbnail will be created
in the Results grid.

Note: Selecting Focus on Clash always returns to the clashes original default viewpoint.

To save viewpoints with clash results automatically

In the Clash Detective window, click the Results tab Display Settings show/hide button.
Select the Auto-Update option from the Viewpoint drop-down list.

Now when you navigate away from the default viewpoint for a clash in the Scene View,
the viewpoint for the clash will be updated to the new position. If there is no existing
viewpoint thumbnail then a new viewpoint thumbnail will be created in the Results grid.
Note: Selecting Focus on Clash always returns to the clashes original default viewpoint.
Once redlining has been added, subsequent changes to the viewpoint due to navigation
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will not be saved. In order to save a different viewpoint, the redlining must first be

removed using the redline Erase tool, or by manually saving the viewpoint.

% ¥ X
Test 1 Last Run: Thursday, June 1, 2017 11:44:54 AM
Clashes - Total: 14 (Open: 14 Closed: 0)
Name Status Clashes lNew | Active I | Pp! R
Test 1 Done 14 14 0 0 0 0

|G AddTest | | Resetan |CompmAuI Delete All |

Rules l Select ‘ Results lReport‘

[ i:fNew Group s @ .9.‘ Assign @

"

qﬁNone VS %5_ eRe-runTes(

Name I8)] @ Status Level Grid In... Found ~Highlighting >
4 (2] New Group New  [JLO2TOP.. B4  11:44:5401-06-2 ;?
@ Clash1 New v L02TOP... B-4 11:44:54 01-06-2 Use item colors ‘1S
@ Clash2 New v LO1GRO... B6-4  11:44:54 01-06-2 Highlight all clashes '55
@ Clash3 New v LO1GRO... B6-4  11:44:54 01-06-2 e — S
@ Clash4 New v L02TOP... D-4 11:44:54 01-06-2
@ Clash5 New v LO2 TOP... D-3 11:44:54 01-06-2 Transparent dimming
® Clashé New v L02TOP.. D-2 11:44:54 01-06-2 [[] Auto reveal
@ Clash? New v LO2TOP.. A-4  11:44:54 01-06-2 _Viewpoint
® Clash8 New v LO2TOP... B.6-3 11:44:54 01-06-2 Auto-update v
® Clash9 New v L02TOP.. C-3  11:44:54 01-06-2 EOR SRS
® Clash10 New v LO2TOP... A-3 11:44:54 01-06-2 Focus on Clash
@ Clash11 New v L02TOP... C-2 11:44:54 01-06-2 —
@ Clash12 New v LO2TOP.. B6-1  11:44:54 01-06-2 ";',:f,i‘:,"simu,aﬁon
@ Clash13 New v LO2TOP.. B6-2  11:44:54 01-06-2
® Clashis New v l02T0P. A2  Traasa0r062 | [(Hiewmcentet =
@ Clash15 New v L02TOP... A-1 11:44:54 01-06-2 e
® Clash16 New v L02TOP.. A1 11:44:54 01-06-2 View
@ Clash17 New v LO2TOP.. C-4  11:44:54 01-06-2
® Clash18 New v LO2TOP.. C-4  11:44:54 01-06-2
l A Items |
< >

Figure 11-3: Clash Detective Results — Viewpoints

@

Figure 11-4: Clash Viewpoint Example
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11.7 Creating reports: HTML

1. In the Clash Detective window, run the desired test. If you ran all tests in the Tests
panel, select the test you want to view the results for.

2. Click the Report tab.

3. Inthe Contents area select the check boxes for the data you want to appear in the report
for each clash result. This can include Quick Properties relating to the items involved in
the clash, how to find them in the standard Selection Tree from root to geometry,
whether images or simulation information should be included, and so on.

4. In the For-Clash Groups Include drop-down list, select how to display the clash groups in
your report.

Note: If your test does not contain any clash groups, this box is not available.

5. Choose from the following options:

Group Headers Only - your report will include summaries of clash groups and
individual clashes not in groups.

Individual Clashes Only - your report will only contain individual clash results,
and will not distinguish those results that have been grouped. For each clash that
belongs to a group, an extra field, called Clash Group, can be added to the report
to identify it. To enable this functionality, select the Clash Group check box in the
Contents area.

Everything - your report will contain summaries of clash groups that you have
created, clash results that are part of each group, and individual clash results.
For each clash that belongs to a group, an extra field, called Clash Group, can be
added to the report to identify it. To enable this functionality, select the Clash
Group check box in the Contents area.

6. Use the Include Clash Types box to select the clash results that you want to report on.
7. Select the type of report in the Report Type box:

Current Test creates a single report file for the current test.
All Tests (Combined) creates a single file containing all results from all tests.
All Tests (Separate) creates a separate file for each test containing all results.

8. Select the format of the report in the Report Format box:

XML creates an XML file containing all the clashes and a jpeg of their viewpoints
alongside their details. On choosing this option, you will need to select or create
a folder for the files and enter a name for the XML file.

HTML will create an HTML file containing all the clashes and a jpeg of their
viewpoints alongside their details. On choosing this option, you will need to select
or create a folder for the files and enter a name for the HTML file.

HTML (Tabular) will create an HTML tabular file containing all the clashes and a
jpeg of their viewpoints alongside their details. On choosing this option, you will
need to select or create a folder for the files and enter a name for the HTML file.
HTML tabular files can be opened and edited in Microsoft Excel 2007 onwards.
Note: To customize the appearance or layout of the HTML / HTML (Tabular) file,
you will need to edit the clash_report_html.xsl / clash_report_html_tabular.xsl file.
The installed file is located in the stylesheets subdirectory of the Autodesk
Navisworks install directory. You can copy the edited file to the stylesheets
subdirectory of any of the Autodesk Navisworks search directories. See Search
Directories for more information.
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» Text creates a TXT file containing all the clash details and the location of a jpeg
of each clash. On choosing this option, you will need to select or create a folder

for the files and enter a name for the TXT file.

» As Viewpoints creates a folder in the Saved Viewpoints dock able window (this
window is automatically displayed when the report is run), with the same name
as the test. Each clash is saved as a viewpoint in this folder, with a comment

attached containing the clash result details.

Note: The Home view is the default camera orientation for clash viewpoints.

9. Click the Write Report button to write the report.

Note: Reports will respect any sorting of the data that you have done, for example into

ascending or descending order, on the Results tab.

X
Clash Detective o
Test 1 Last Run: Thursday, June 1, 2017 11:44:54 AM

Clashes - Total: 14 (Open: 14 Closed: 0)

Name Status Clashes I New Active Reviewed I Approved Resolved
Test 1 Done 14 14 0 0 0 0
|G AddTest | | Resetall | CompactAll | Delete All B~

Rules I Select lResults Report

Contents Include Clashes
Summary For Clash Groups, include:
Clash Point Group Headers Only v
Date Found [T] Include only filtered results
Assigned To Include these statuses:
Date Approved

| New
Approved By Active
Vi
Layer Name

It::n Path Reviewed
tem ID Approved
Status Resolved
Distance
[] Description
Comments
Quick Properties
Image
Simulation Dates
Simulation Event
Clash Group
Grid Location

Output Settings
Report Type Report Format

Current test v | | HTML v Write Report
| Preserve result highlighting
< >

Figure 11-5: Clash Detective Report

Page 96



12 The TlmeLlner

In this chapter:

Configuring appearances

Creating tasks

Adding selection sets to a task

Adding multiple tasks and running the movie
Simulating settings

Exporting the TimeLiner

Adding a data source
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12.1 Configuring appearances

The TimeLiner tool adds schedule simulation to Autodesk Navisworks. TimeLiner imports
schedules from a variety of sources. You can then connect tasks in the schedule with objects in
the model to create a simulation. This allows you to see the effects of the schedule on the
model, and compare planned dates against actual dates. Costs can also be assigned to tasks to
track the cost of a project throughout its schedule. TimeLiner also allows the export of images
and animations based on the results of the simulation. TimeLiner will automatically update the
simulation if the model or schedule changes.

You can combine the functionality of TimeLiner with other Autodesk Navisworks tools:

» Linking TimeLiner and Object Animation together enables the triggering and scheduling
of object movement based on start time and duration of project tasks, and can help you
with workspace and process planning. For example, a TimeLiner sequence may indicate
that when a particular site crane moves from its start point to its end point over the
course of a particular afternoon, a workgroup working nearby causes an obstruction
along its route. This potential obstruction problem can be resolved before going to site
(e.g., the crane can be moved along a different route, the workgroup moved out of the
way, or the project schedule altered). See Add Animation to TimeLiner Schedules for
more information.

» Linking TimeLiner and Clash Detective together enables the time-based clash checks on
the project. See Clash Detective User Guide for further details on time-based clashing.
Note: This feature is available for Autodesk Navisworks Manage users only.

» Linking TimeLiner, Object Animation, and Clash Detective together enables clash testing
of fully animated TimeLiner schedules. So, instead of visually inspecting a TimeLiner
sequence to make sure, for example, that the moving crane didn't collide with a
workgroup, you can run a clash test.

Note: This feature is available for Autodesk Navisworks Manage users only.

12.2Creating tasks

1. Load your model into Autodesk Navisworks (see Open Files if you need help).

2. Click Home tab » Tools panel » TimeLiner k-L) and click the Tasks tab in
the TimeLiner window.

=i
3. Click Add Task ¥ or right-click anywhere in the task view, and click Add Task on the
context menu.

=
Note: You can click on an existing task and select Insert Task Ii‘ to insert a task above
the selected task.
4. Enter the name for your task, and press Enter. The task is now added to your schedule.
Note: If you press Enter when the bottom task in the task view is selected, then a new
task will be created below it.
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12.3 Adding selection sets to a task

12.3.1 To add tasks based on the Selection Tree structure
1. If the TimeLiner window is not already open, click Home tab » Tools panel » TimeLiner

e
2. In the TimeLiner window Tasks tab, click Auto-Add Tasks s

3. Click For Every Topmost Layer if you want to create tasks with the same names as each
topmost layer in the Selection Tree.
Click For Every Topmost Item if you want to create tasks with the same names as each
topmost item in the Selection Tree. This can be a layer, a group, block or cell, or
geometry, depending on how the model is constructed.

Note: Planned Start and End dates will be automatically created, starting from the current
system date and incrementing by one day for each subsequent end and start date. The Task
Type will be set to Construct.

TimeLiner

Tasks | Data Sources I Configure l Simulate

[Fadars [ [ Q- [ [ @atacn -] o | 5 | 48~ gz (@ @E] BEEBBE
Active Name Status | Planned Start | Planned End | Actual Start = ActualEnd | Task Type | Attached | Total Cost

s I N A T i e s

Task 2 P * 6/3/2017 6/4/2017 6/3{2017 6/4/2017 Demolish Explicit S...
Task 3 I , 6512017 6/6/2017 6/5/2017 6/6/2017 Temporary Explicit S...

Figure 12-1: Adding Timeliner Tasks

12.3.2 To build tasks from a data source

1. If the TimeLiner window is not already open, click Home tab » Tools panel »
TimeLiner O

2. Inthe TimeLiner window, the Data Sources tab, click the Refresh button, select
either Selected Data Source or All Data Sources then select Rebuild Task Hierarchy in
the Refresh from Data Source Dialog Box and click OK.
This will import all of the tasks from the project file into TimeLiner.
Note: You can also right-click on a file in the Data Sources tab and select the Rebuild
Task Hierarchy option.

3. Click the Tasks tab to view the created tasks. The task table is populated in accordance
with predefined settings for the data source. You can make any necessary overrides in
the Field Selector Dialog Box.

Note: Although the tasks have now been imported into TimeLiner, you still need to Attach Tasks
to Geometry before you can run a simulation. The fastest way to attach imported tasks is by
applying rules (see Use Rules to Attach Tasks).
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12.4 Adding multiple tasks and running the movie
1. If the TimeLiner window is not already open, click Home tab » Tools panel » TimeLiner

2. On the Tasks tab, click the task you want to add an animation to, and use the horizontal
scroll bar to locate the Animation column.

3. Click the drop-down arrow in the Animation field, and select a scene or an animation set
from a scene. When you select a scene, all animation sets recorded for this scene will
be used.

4. Click the drop-down arrow in the Animation Behavior field, and select how the animation
will play during this task:

» Scale - the duration of the animation is matched to the duration of the task. This
is the default setting.

» Match Start - the animation starts when the task starts. If the animation runs past
the end of the TimeLiner simulation, the end of the animation will be clipped.

* Match End - the animation starts early enough so that it ends just when the task
end. If the animation starts before the beginning of the TimeLiner simulation, the
start of the animation will be clipped.

12.5Simulating settings

The Settings button on the Simulate tab provides access to the Simulation Settings dialog box.

It is possible to override the Start and End dates that the simulation runs between. Selecting the
Override Start/End Dates check box enables the date boxes and allows you to choose the start
and end dates. By doing this, you can simulate a small sub-section of the overall project. The
dates will be shown on the Simulate tab. These dates will also be used when exporting
animations.

TimeLi
Tasks | Data Sources [ Configure | Simulate
> | 0> | P
[6172017 ] 09:00
55 | [settings.. | €7172017
Thu Jun 01, 17 Fri Jun 02, 17 Sat Jun 03, 17 Sun Jun 04, 17 Mon Jun
@ @ Mame | Status | Planned Start | Planned End | Actual Start = ActualEnd | Total Cost
PM AM PM AM PM AM PM AM
» O A T T O O O
Pending Taskz = 6/3/2017 6/4/2017 6/3/2017 6/4/2017 De [ ]
Pending Task3 = 6/5/2017 6/6/2017 6/5/2017 6/6/2017 Te

Figure 12-2: Simulate Tab
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Figure 12-3: Simulate Settings

You can define the Interval Size to use when stepping through the simulation using the playback
controls. The interval size can be set either as a percentage of the overall simulation duration or
to an absolute number of days or weeks, and so on.

Use the drop-down list to select the interval unit, then use the Up and Down arrow buttons to
increase or decrease the interval size.

It is also possible to highlight all the tasks that are being worked on during the interval. By
selecting the Show All Tasks in Interval check box, and, for example, setting the Interval Size to
5 Days, all tasks being worked on during those 5 days will be set to their Start Appearance in
the Scene View, including those that begin and end within the bounds of the interval. The
Simulation slider will show this by drawing a blue line under the slider. If this check box is clear,
tasks that begin and end within the bounds of the interval will not be highlighted in this manner,
and will need to overlap with the current date in order to be highlighted in the Scene View.

You can define the overall Playback Duration for the complete simulation (the time needed to
play it through from start to finish). Use the Up and Down arrow buttons to increase or decrease
the duration (in seconds). You may also enter a duration directly into this field.

You can define whether the current simulation date should be overlaid in the Scene View, and if
so whether it should appear at the top or bottom of the screen. From the drop-down, choose
from None (to display no overlay text), Top (to display the text at the top of the window), or
Bottom (to display the text at the bottom of the window).

You can Edit the information displayed in the overlay text using the Overlay Text Dialog Box.
This dialog box also makes it possible to alter the Font Type, Style and Size by clicking on the
contained Font button.

You can add animation to an entire schedule, so that during the TimeLiner sequence playback,
Autodesk Navisworks will also play the specified viewpoint animation or camera.

The following options can be selected in the Animation field:

* No Link - no viewpoint animation or camera animation will be played.
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Saved Viewpoints Animation - links your schedule to the currently selected viewpoint or
viewpoint animation.

Scene X - Camera - links your schedule to a camera animation in the selected animation
scene.

You can pre-record suitable animations for use with the TimeLiner simulation (see Record and
Play Animations). Using animation also affects the Animation Export.

View area. Each view will playback the schedule depicting Planned and Actual relationships:

Actual. Choose this view to simulate the Actual schedule only (that is, only use the
Actual Start and Actual End dates).

Actual (Planned Differences). Choose this view to simulate the Actual schedule
against the Planned schedule. This view will only highlight the items attached to the task
over the Actual date range (that is, between Actual Start and Actual End. See diagram
below for graphical representation). For time periods where the Actual dates are within
the Planned dates (on schedule), the items attached to the task will be displayed in the
Task Type Start Appearance. For time periods where the Actual dates are early, or late
in comparison to the Planned dates (there is a variance), then the items attached to the
task will be displayed in the Task TypeEarly or Late Appearance, respectively.

Planned. Choose this view to simulate the Planned schedule only (that is, only use the
Planned Start and Planned End dates).

Planned (Actual Differences). Choose this view to simulate the Actual schedule
against the Planned schedule. This view will only highlight the items attached to the task
over the Planned date range (that is, between PlannedStart and Planned End. See
diagram below for graphical representation). For time periods where the Actual dates are
within the Planned dates (on schedule), the items attached to the task will be displayed
in the Task TypeStart Appearance. For time periods where the Actual dates are early, or
late in comparison to the Planned dates (there is a variance), then the items attached to
the task will be displayed in the Task TypeEarly or Late Appearance, respectively.
Planned Against Actual. Choose this view to simulate the Actual schedule against the
Planned schedule. This will highlight the items attached to the task over the entire
Planned and Actual date range (that is, between the earliest of Actual and Planned Start
dates and the latest of Actual and Planned End dates. See diagrams below for graphical
representation). For time periods where the Actual dates are within the Planned dates
(on schedule), the items attached to the task will be displayed in the Task Type Start
Appearance. For time periods where the Actual dates are early, or late in comparison to
the Planned dates (there is a variance), then the items attached to the task will be
displayed in the Task Type Early or Late Appearance, respectively.

12.6 Exporting the TimeLiner

1.

2.

In the TimeLiner window, Simulate tab, click Export Animation lﬁ'.

The Animation Export dialog box opens.

To export the currently selected viewpoint animation, select Current Animation in the
Source box.

To export the currently selected object animation, select Current Animator Scene in the
Source box.

To export a TimeLiner sequence, select TimeLiner Simulation in the Source box.
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3. Set up the rest of the boxes in the Animation Export dialog box, and click OK. For more
information, see Animation Export Dialog Box.

4. Inthe Save As dialog box, enter a new filename and location, if you want to change from
those suggested.

5. Click Save.

12.7 Adding a data source

12.7.1 To import data from an external project schedule
1. If the TimeLiner window is not already open, click Home tab > Tools panel »

TimeLiner O
2. Inthe TimeLiner window click the Data Sources tab.
3. Click the Add button and choose the required option from a list of the project sources

that may be connected to on the current PC.
Note: For more information on which sources are typically available, see Supported
Scheduling Software.

4. Use the standard Open dialog box to browse to and open the desired project file.
TimeLiner accesses the selected file in accordance with the predefined parameters
configured for the corresponding data source using a COM interface.

Depending on the data source, the Field Selector Dialog Box may be displayed. You can
use it to override some of the predefined data import options.

5. By default, your data source is called “New Data Source(x)”, where “x” is the latest
available number. To make your data source more descriptive, right-click it,
click Rename on the context menu, and enter a new name.

12.7.2 To import data from a Primavera

Note: This procedure shows how to import data from a Primavera P6 project. Follow the same
steps to import data from a Primavera P6 V7, V8 or V8.2 project, selecting the Primavera P6
V7, V8, or V8.2 options where applicable.

1. If the TimeLiner window is not already open, click Home tab > Tools panel »

TimeLiner kL)
2. In the TimeLiner window, click the Data Sources tab.
3. Click the Add button and click Primavera P6 (Web Services).

Note: If you can’t see this option, you must set up a Primavera Web Server first. Refer to
the Primavera P6 Web Server Administrator Guide (available in your Primavera
documentation).

4. When the Primavera login dialog box is displayed, enter your user name, password, and
the server address.
Tip: The Server Address is the name of a machine on your domain or an IP address for
the server.

5. In the Primavera P6 Database Instance Selection dialog box double-click the
desired Instance ID to select it.

6. Inthe Primavera P6 Project Selection dialog box double-click the desired project file to
open it.
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7.

12.7.3

SEN

B

6.

Use the Field Selector Dialog Box to override some of the predefined data import
options.
TimeLiner connects to the selected project file.

To import CSV data
If the TimeLiner window is not already open, click Home tab » Tools panel »

TimeLiner -~/

In the TimeLiner window click the Data Sources tab.

Click the Add button and click CSV Import.

Use the standard Open dialog box to locate the desired project file in CSV format, and
click Open.

In the Field Selector Dialog Box, use the CSV Import Settings area to specify how your
data should be imported into TimeLiner.

Note: The CSV import settings, including field mappings, are remembered by the system
and pre-populated when the dialog box opens. If you are linking to a different CSV file
than was previously used, TimeLiner will attempt to map any columns to similarly-named
columns in the CSV file.

You should have a column in the CSV file containing unique data, for example an
incrementing number, and map it to the Synchronization ID field. This unique data must
remain the same once it has been set against a row in the CSV file to enable
synchronization to enable you to rebuild and synchronize the data source link. The Task
Name field must also be mapped.

» Select the Row 1 Contains Headings check box if you want the first row of data in
your CSV file to be treated as column headings. TimeLiner will use it to populate
the External Field Name options in the grid.

If the first row of data in your CSV file does not contain column headings, clear
this check box.

» Select the Automatically Detect Date and Time option if you want TimeLiner to
attempt to determine the date/time format used in your CSV file.

First, TimeLiner applies a set of rules to try to establish the date/time format used
in the document; if it is not possible, it uses the local settings on your system.
Select the Use Specific Date/Time Format option if you want to manually specify
the date/time format that should be used. When this radio button is selected, you
can enter the required format into the box provided. For the list of valid codes,
see Field Selector Dialog Box.
Note: If one or more date/time-based columns are found to contain fields where
the data cannot be mapped to a valid date/time value using the manually-
specified format, TimeLiner will 'fall back' and attempt to use the automatic
date/time format.

By default, your data source is called “New Data Source(x)”, where “x” is the latest

available number. To make your data source more descriptive, right-click it,

click Rename on the context menu, and enter a new name.
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12.7.4 Timeliner Simulate Example

Figure 12-4: Timeliner Simulation Example
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In this chapter:
Setting up your workbook

Dragging items to the workbook
Taking off the entire model

Exporting the takeoff
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13.1 Setting up your workbook

Quantification supports integration of three-dimensional (3D) and two-dimensional (2D) design
data. You can combine multiple source files and generate quantity takeoff. Takeoff an entire
building information model (BIM) and create synchronized project views that combine
information from BIM tools such as Revit® and AutoCAD® software together with geometry,
images, and data from other tools. You can also perform a virtual takeoff for items with no
associated model geometry or properties.

Your takeoff data can then be exported to Excel for analysis and shared with other project team
members in the cloud using Autodesk BIM 360® for optimized collaboration.

Quantification can count and measure item quantities associated with these disciplines:

» Civil (earth, road, drainage)
» Architecture (doors, walls, windows)
» Engineering (structural, mechanical, electrical, plumbing)

The available measurements (variables) are:

* Length

* Width

* Thickness
* Height

e Perimeter
 Area

« Volume

«  Weight

e« Count

13.1.1 Quantification workflow

A typical workflow begins with a design file created in Autodesk design applications, such as
AutoCAD, AutoCAD Architecture, AutoCAD Civil 3D, and Revit. Before publishing a design file,
an architect, engineer, or other designer, determines which features (model, layouts, layers,
properties and so on) to include in the file. After determining the content, a designer publishes
the drawing and shares the file with the Estimator. In some cases, designers scan or save
drawings as image files and send them for estimation. When the files are received, the
Quantification workflow begins.

In Navisworks, open a design data source file

Open the Quantification workbook

Set up a project

Create or select takeoff items

Hide unwanted items

Use measurement tools for items not in catalog (for virtual takeoff)
Organize takeoff items (change item order, create new items)
Edit formulas/parameters

Refresh model after changing data

10 Analyze and validate takeoff data

11. Output takeoff data to Excel XLSX format

©CoNOOh~wWN =
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13.2Dragging items to the workbook

EE
1. Open the Quantification ®= window in the Home Tab.

2. Click and drag to the title bar at the top or side of the window.
3. Optional: to prevent a window from automatically docking while you drag it, hold down
the CTRL key.

Note: The docking tool allows you to place windows in a specific relationship to the canvas
areas.

13.3 Taking off the entire model

Virtual takeoff can be carried out when you want to add takeoff objects that are not linked to a
model object or item, for example:

* where an object has geometry, but has no properties
» where an object does not have geometry, and has no properties

This could be the case if you did not save the properties from the original design application with
your file, or that the object you want to takeoff does not exist in the model. In both cases, you
can associate a viewpoint with the virtual takeoff object so you can navigate your way back to it
during the takeoff process. Once your virtual object is taken off, you can begin to add properties
by using formulas, which provides quantities for the object.

Note: You cannot refresh a virtual takeoff, since it is not linked to the model.

Quantification Workbook

m (/QJ l [ g' ] | Q)Model Takeoff V| [%Virmal Takeoff v '::\J Hide Takeoff ':,Show Takeoff I [qv (

- - -

Items WBS
[Ch Columns
[Ch Plates
l:“\ PED 18" x 18"(1)

[} 6" Concrete(1)

howWwoNN -

Figure 13-1: Quantification Take-off Tools

13.3.1 Takeoff objects with no properties

If you want to takeoff objects that have geometry in the model, but no associated properties, you
can use a virtual takeoff. This may be the case if you did not save the object properties from the
original design application, such as AutoCAD or Revit. In this instance, you can use
measurement tools and formulas to add some property details to the Quantification workbook.
You can also associate a viewpoint with the takeoff object, to help reference its position in the
model.

13.3.2 Takeoff unmodeled objects
You can capture the quantities of objects that do not appear in the model using a virtual takeoff.
Virtual takeoff takes advantage of viewpoints, formulas, measurements, and manual overrides.
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You can add a virtual takeoff to an existing Item, then associate a Viewpoint for that Item, which
you can update and refer back to, make measurements and create redlines. The camera icon in
the Viewpoint field denotes the associated Viewpoint. Click it to view the Item in the Scene.

13.3.3 Perform 2D takeoff

2D Takeoff allows you to measure lines, areas and counts on a 2D sheet. Rather than carrying
out manual calculations on paper sheets, you can markup geometry and perform accurate
calculations. The geometry is then taken off automatically, to sit alongside the 3D takeoffs in
your Quantification workbook.

2D Takeoff supports native and scanned DWF files and non-native DWFs files such as PDF.
See Supported file types.

2D Takeoff Workflow:

» Select or create an Item in the Items Catalog.

» Open the 2D sheet you want to use. If your project contains several sheets or models,
use the Sheet Browser to select a 2D sheet.

o Select a Markup tool from the 2D Takeoff toolbar.

*  Draw your markup on the sheet.

* Your Takeoff results appear in the Quantification workbook.

13.4Exporting the takeoff

To export Quantification data

1. In the Quantification Workbook, click Import/Export Catalogs and Export

Quantities |@

From the drop-down list, click Export Quantities to Excel
Save the file to your preferred location

wn
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14 Presentlng, Anlmatlng, and Exporting

In this chapter:

Animating saved viewpoints
Animating objects

Creating a script
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14.1 Animating saved viewpoints

There are two ways to create viewpoint animations in Autodesk Navisworks. You can either
simply record your real-time walk through, or you can assemble specific viewpoints for Autodesk
Navisworks to interpolate into a viewpoint animation later.

Viewpoint animation is controlled through the Animation tab and the Saved Viewpoints window.

It is worth remembering that you can hide items in viewpoints, override colors and
transparencies and set multiple section planes and these will all be respected by a viewpoint
animation. This way you can easily create powerful viewpoint animations.

Once a viewpoint animation is recorded, you can edit it to set the duration, the type of
smoothing and whether it loops or not.

There is also nothing to stop you from copying viewpoint animations (hold down the CTRL key
when dragging an animation on the Saved Viewpoints window), dragging frames off the
animation into a blank space on the Saved Viewpoints window to remove them from the
viewpoint animation, editing individual frames attributes, inserting cuts or dragging other
viewpoints or viewpoint animations onto the existing one, to continue developing your
animations.

14.1.1 Animation Cuts (Pauses)

Cuts in a viewpoint animation are simply points where the camera pauses for a while. They are
inserted automatically when you click Pause during the interactive recording of a viewpoint
animation, or you can insert them manually into an existing viewpoint animation.

14.1.2 To create a viewpoint animation in real time

VA
/ A\

1. Click Animation tab » Create panel » RecordL\._./J.
To the far right of the Animation tab, notice that the Recording panel displays.

2. Navigate around in the Scene View while Autodesk Navisworks records your movement.
You can even move the section planes through the model during your navigation, and
this will be recorded into the viewpoint animation too.

3. At any point during the navigation, click Animation tab » Recording panel » Pauseﬂ H
This will pause the recording while you maneuver into a new position. To continue

recording the viewpoint animation, click Pause again.
The resulting viewpoint animation will contain a cut for the duration of the pause.

4. When finished, click Animation tab » Recording panel » Stop
The animation is saved automatically in the Saved Viewpoints wmdow (click View tab »
Workspace panel » Windows drop-down > Saved Viewpoints). Your new viewpoint
animation is called “AnimationX”, where “X” is the latest available number. The name will
be editable at this point if you want to name it yourself. This viewpoint animation will also
become the current active animation in the Available Animations drop-down list on
the Playback panel of the Animation tab.

While the above method is useful for creating quick viewpoint animations on the fly, sometimes
you need more control over the viewpoint camera. To do this in Autodesk Navisworks, you need
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to set up several viewpoints and add them to an empty viewpoint animation. When playing back
the animation, Autodesk Navisworks will then interpolate between these viewpoints.

14.1.3 To create an animation frame by frame

1.

2.

If necessary, display the Saved Viewpoints window (click View tab »

Workspace panel » Windows drop-down » Saved Viewpoints).

Right-click the Saved Viewpoints window and select Add Animation.

A new viewpoint animation is created, called “AnimationX”, where “X” is the latest
available number. The name will be editable at this point if you want to name it yourself.
There will be no plus sign next to the new viewpoint animation because it is empty.
Navigate to a position in the model you would like to add to your animation and save the
new location as a viewpoint. (Right-click the Saved Viewpoints window and select Save
Viewpoint.) Repeat this step as desired. Each viewpoint will become a frame for the
animation. The more frames you have, the smoother and more predictable the viewpoint
animation will be. See Save Viewpoints for more information on creating viewpoints.
When you have all required viewpoints, drag them onto the empty viewpoint animation
you just created. You can drag them on one-by-one, or you can select multiple
viewpoints using the CTRL and SHIFT keyboard keys and drag several on at once.

If you drop them onto the viewpoint animation icon itself, then the viewpoints will become
frames at the end of the animation, but you can drop the viewpoints anywhere on the
expanded animation to put them where you wish.

At this point, you can use the Playback Position slider on the Playback panel of

the Animation tab to move backward and forward through the viewpoint animation to see
how it looks.

You can edit any of the viewpoints inside the viewpoint animation (see Edit

Viewpoints for details on this), or you can add more viewpoints, delete them, move them
around, add cuts, and edit the animation itself until you are happy with the viewpoint
animation.

Saved Viewpoints x II

#-3J 3D View

= n Animation
@ View
1) view (1)
1) view (2)
1) view (3)
1) view (4)

Figure 14-1: Animation and Related Viewpoints
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Figure 14-2: Playback Panel

Once you have several viewpoint animations, you can drag and drop them onto a master
viewpoint animation to compose more complex combinations of animations, just like dragging
and dropping viewpoints onto an animation as a frame.

14.2 Animating objects

@)

Animation tab » Create panel » Animatorq\%

With the Animator, scenes can be created. Under those scenes, animations can be established.
A scene could be a door and the animation would be that door opening and closing. To create
an animation for a scene, select the object or set of objects to be animated. Attach them to the
animation set by right-clicking the name of that animation set and selecting “Add Animation Set”
and “From Current Selection”. Then use the following tools to create the animation itself. To
control time in the animation, use the right side of the Animator dialog box.

. ﬁ Puts Animator into translation mode. The Translation gizmo is displayed in
the Scene View, and enables you to modify the position of the geometry objects.
This mode remains active until you select a different object manipulation mode
from the toolbar

. .hﬂ. Puts Animator into rotation mode. The Rotation gizmo is displayed in the
Scene View, and enables you to modify the rotation of the geometry objects. This
mode remains active until you select a different object manipulation mode from
the toolbar.

« & Puts Animator into scale mode. The Scaling gizmo is displayed in the Scene
View, and enables you to modify the size of the geometry objects. This mode
remains active until you select a different object manipulation mode from the
toolbar.

. .. Puts Animator into color mode. A color palette is shown in the Manual Entry
bar, and enables you to modify the color of the geometry objects.

. @ Puts Animator into transparency mode. A transparency slider is shown in the
Manual Entry bar, and enables you to modify the transparency of the geometry
object

. "%iTakesa snapshot of the current change to the model as a new keyframe in
the timeline view.
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.ﬁl. Enables/disables snapping. Snapping only comes into effect when moving
objects by dragging the gizmos in the Scene View, and has no effect on
numerical entry or keyboard control.

[scene 1 "] Selects the active scene.
0:10.00 | Controls the current position of the time slider in the timeline
view.

__lKK]: Rewinds the animation back to the beginning.
__‘q”: Rewinds one second.

= Plays the animation backward from the end point to the start, and then stops.
This does not alter the direction that the animated elements face.

W Pauses the animation. To continue playing, click Play again.
:D: Stops and rewinds the animation to the beginning.

__L:’: Plays the animation forward from the starting point to the end.
_.UD: Plays the animation forward one second.

.m. Fast forwards the animation to the end.

Animator
Q) sa @G 5 @8] |scene 2 v Jo:00.00 1 |1 KIS 00 = S MO
00100 00200 OXC00 OO0 O0NS00 0XS00 O0NTO0 O0X200 0X54
|.Name Active Loop  P.P. Infribel
i~ Scene1 O O O
EI Scene 2 O O O

Animation Set 1

(@0 & & &[>

Figure 14-3: Animator Dialog Box
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&.

Figure 14-4: Example Animator Rotation Gizmo

14.3Creating a script

Click Animation tab » Scripts panel » Scripter S

Add a script % Choose how it will exist in the model by adding events & © L &xd@s o &@
A script will create a trigger for an animation. Scripts can be tied to hot-keys, hotspots in the
model, and more. If triggered, the animation associated with it will play.

A script can be modified in the right side of the Scripter Dialog Box under Properties.

Click Animation tab » Scripts panel » Enable Scriptsg.

This will turn on scripts and allow a user to interact with the model. For example, if there is a
script to open a door associated with pressing a specific key on the keyboard, pressing this key
will open the door.

Scripter

Scripts Events Properties
Hotspot  Sphere v

Name
i New Script

>
KRz
i

Trigger when |Entering v
Hotspot Type

Position X >0ﬁ0|n Y |oft Oin ‘Z 0ftOin  |ft
Redus () [from ]

L New Script (1)

CEEE IR

Actions

| =g 00| @ P & & ©

ol
gJ
©

Figure 14-5: Scripter Dialog Box
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